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ABSTRACT 
 

Neuroinflammation is a fundamental hallmark of several chronic neurodegenerative 

diseases, including Parkinson’s disease (PD), and is closely associated with microglial activation. 

PD is characterized by the progressive loss of dopaminergic neurons in the substantia nigra and 

the accumulation of misfolded α-synuclein (αSyn) protein aggregates in surviving neurons. A key 

signaling mechanism that activates chronic inflammation is based on NLRP3 inflammasome 

activation, which can occur via aggregated forms of amyloid-β (Aβ) and αSyn. The inflammasome 

adaptor protein, ASC, has an intrinsic ability to oligomerize and, upon cell death, is released as 

specks into the extracellular space. These ASC specks are recognized by microglia as ‘danger 

signals’, thereby driving inflammation and neurodegeneration. Recent evidence has suggested 

that extracellular ASC specks can bind Aβ, and that the internalization of ASC-Aβ complexes by 

microglia results in the amplification and perpetuation of pro-inflammatory responses. 

Moreover, studies on human samples and preclinical animal models of PD have established a link 

between αSyn aggregation, microglial NLRP3 inflammasome activation and neuronal cell death. 

However, the underlying molecular mechanisms that perpetuate chronic inflammatory 

responses are incompletely understood. In this study, I produced ASC-αSyn complexes and 

evaluated their effects on NLRP3 inflammasome activation using a mouse SIM-A9 microglial cell 

culture model. Examination of electron microscopic images revealed that αSyn was found in close 

proximity and clustered around ASC fibrils. I further demonstrated that ASC-αSyn complexes 

were capable of activating the NLRP3 inflammasome to a greater extent than ASC or αSyn alone. 

This was determined by an increased expression of the NLRP3 sensor at the protein level, 

augmentation of ASC speck formation and activation of caspase-1. In addition, ASC-αSyn 
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complexes triggered caspase-1-dependent interleukin (IL)-1β/IL-18 processing by SIM-A9 cells, 

resulting in increased release of IL-1β and IL-18 into their conditioned media. This study links ASC 

and αSyn to mechanisms that amplify pro-inflammatory responses, thereby promoting a state of 

chronic inflammation. Overall, these results reveal a role for ASC specks in perpetuating 

inflammation and point at the possible importance of ASC-αSyn complexes, as triggers, in the 

propagation and exacerbation of αSyn-linked pathology. 
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1.  INTRODUCTION 

1.1 Parkinson’s disease 
 

Parkinson's disease (PD) is the world’s second most prevalent neurodegenerative disease, 

affecting 2-3% of the population aged over 65 years (1). Neurological disorders are currently the 

leading source of disability around the world and PD is the fastest growing of these disorders in 

age-standardized rates of prevalence, disability, and deaths (2). Triggered by aging populations, 

increasing longevity, and the by-products of industrialization, PD prevalence and incidence are 

dramatically increasing and have been termed the ”Parkinson pandemic” (3). PD is clinically 

characterized by several motor symptoms, such as bradykinesia, rigidity, tremors, and with 

progression, postural instability. However, non-motor signs, such as sleep disorders, hyposmia, 

neuropsychiatric symptoms, cognitive impairment, and pain are also present and may occur prior 

to the onset of motor features, contributing to its overall disability (4,5). While the cause of PD 

remains unknown, the risk of developing PD appears to result from a complex interplay of genetic 

and environmental factors that converge on immune function and inflammation, affecting 

several important cellular processes (6).  

Two key neuropathological hallmarks of PD at autopsy include 1) the relatively selective 

loss of dopaminergic neurons in the Substantia nigra pars compacta (SNpc), although 

neurodegeneration is not limited to only the nigral dopaminergic neurons and encompasses cells 

located in other circuits, and 2) the presence of intracellular inclusions of aggregated and 

misfolded α-synuclein (αSyn) protein, termed Lewy bodies, in the surviving neurons (7). Excessive 

accumulation and spreading of ‘toxic’ αSyn aggregates are widely presumed to be major 
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molecular events underlying PD pathogenesis (8). Consequently, PD has been classified within a 

heterogenous group of diseases termed α-synucleinopathies, in which PD is the most prevalent. 

It is important to highlight that the existence of co-pathologies in PD, for instance, the 

development of amyloid-β (Aβ) plaques, tau-containing neurofibrillary tangles, and TAR DNA-

binding protein 43 (TDP-43) protein inclusions, also occur within the nigrostriatal system and in 

other brain regions (9). Yet, current symptomatic treatments, such as levodopa supplementation, 

deep brain stimulation and physical therapy, cannot significantly slow or halt disease progression 

and impact the underlying disease pathology. 

 

1.2 The structure and role of αSyn 

αSyn is an intracellular, 14 kilodalton (kDa)-sized protein composed of 140 amino acids. 

In healthy neurons and other cell types, αSyn predominantly exists in the form of unfolded 

monomers (10–12). As monomeric αSyn lacks a native three-dimensional (3D) structure, it is 

considered an intrinsically disordered protein. Thus, it is characterized by structural flexibility and 

susceptibility to modifications, rendering αSyn prone to misfolding and aggregation (13). 

Attributable to its flexibility, monomeric αSyn can dynamically interconvert between various 

conformational states, which is influenced by environmental conditions and the molecular 

characteristics of different αSyn domains (14,15). Natively unfolded αSyn monomers may take 

the form of an α-helix, tetramer, or membrane-bound multimer. Several factors, such as intrinsic 

properties of the protein, biological and chemical stimuli, mutations of the αSyn gene (SNCA), 

and post-translational modifications, may initiate misfolding of αSyn and aggregation. αSyn 

proteins can assume structurally distinct amyloid-like conformations, referred to as strains, and 
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such structural variations can be observed in αSyn deposits, differing across PD patients and 

neurologically-related conditions (16,17). Conformations of αSyn range from monomeric, 

oligomeric, fibrillar, and combined forms, which impact the interaction of αSyn with microglia 

and their subsequent internalization (18). Thus far, the direct mechanism of αSyn aggregation is 

not well understood. It is considered that αSyn participates in a multifactorial process wherein 

an unfolded monomer undergoes primary nucleation, elongation, and secondary nucleation (19). 

During primary nucleation, monomers self-assemble to form soluble oligomeric intermediates 

(nuclei). Elongation includes the addition of monomers to existing aggregates, leading to the 

formation of highly organized structures, such as protofibrils and fibrils. Finally, during secondary 

nucleation, fibrils may further form nucleation centers and provide autocatalytic amyloid 

amplification and contribute to the rapid generation of new aggregates or further assemble into 

Lewy bodies (Figure 1B) (20). A study showed that 10 years after transplantation of dopamine 

cells in humans, surviving human fetal neurons adopt the histopathology of PD, suggesting that 

classical Lewy body formation takes a decade to achieve (21–24). 

The primary amino acid sequence of αSyn includes three characteristic regions: N-

terminal, non-amyloid-β-component (NAC), and C-terminal, all of which, possess different 

properties (Figure 1A) (25). The amphipathic N-terminal region (residues 1-60) frequently adopts 

an α-helical structure and functions as an anchor for lipid membrane binding (26). The tendency 

of membrane-bound, monomeric αSyn to exist as an α-helix is increased when features, for 

instance membrane curvature or lipid rafts within cell or vesicle membranes, are present (25). 

Moreover, under physiological conditions, αSyn monomers are N-terminally acetylated, which 

assists in preserving their structures and preventing spontaneous aggregation (27). The central, 
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hydrophobic NAC region (residues 61-95) is involved in the regulation of αSyn transport within 

axons and has a tendency for adopting a cross-β-sheet structure (28). Consequently, the cross-β-

sheet structure promotes protein aggregation and fibrillization by recruiting further monomers, 

ultimately leading to the formation of amyloid fibrils (29). The acidic C-terminal region (residues 

96-140) structurally displays a flexible random coil arrangement and is involved in calcium-

mediated synaptic vesicle binding, thus promoting membrane fusion and neurotransmitter 

release (30–32). While engaging with the N-terminal via long-range electrostatic interactions, the 

C-terminal provides an electrostatic defence which prevents the NAC region from engaging in 

cross-β-sheet folding. Truncation of the C-terminal region may suggest an increased exposure of 

the NAC region, thus promoting a pro-aggregatory conformational state (33). Indeed, truncation 

of the C-terminal has been estimated to occur in 10-30% of total αSyn within Lewy Bodies (34).  

In the healthy brain, αSyn is enriched in the presynaptic terminals of neurons as a lipid-

associated, readily soluble protein that regulates presynaptic vesicle turnover (35). αSyn is well-

conserved in mammals and expressed in non-neuronal and innate immune cells of the central 

nervous system (CNS), such as microglia (36,37). Despite extensive research, the complete 

understanding of the function of αSyn remains ambiguous. However, it has been suggested that 

αSyn has a potential role in regulating essential synaptic processes due to the preferential 

localization of αSyn and its strong affinity for synaptic proteins (19). Native αSyn mutually 

interacts with molecular chaperones, downregulates proapoptotic factors, and supports 

neurogenesis, acting as a potential neuroprotective agent (38–42). Several reports have revealed 

that αSyn modulates dopaminergic signalling, such as by negatively regulating its reuptake, as PD 

is characterized by the decline of dopaminergic neurotransmission (43,44).  
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Moreover, it has been reported that αSyn serves as a critical mediator of inflammatory 

and immune responses by the host, and αSyn is required for the development of a normal 

inflammatory response (45). αSyn also comprises an anti-viral role in which expression of αSyn 

restricts RNA viral infections in the brain (46). In PD patient brains, synaptic accumulation of 

aggregated and misfolded αSyn results in synaptic impairments, and aberrant neural network 

activity, ultimately leading to cell death (47,48). Importantly, loss-of-function of the native 

protein leads to synaptic disturbances, which has been proposed as one of the earliest molecular 

events driving PD (8,49).  

Further, αSyn is a very stable protein with a long half-life that can circulate in the brain 

and serve as part of a platform for pathology spread (50). Besides its several intracellular 

functions, αSyn is considered to spread in a prion-like manner, as shown by the grafting of fetal 

mesencephalic dopaminergic neurons into the SN of PD patients, which later developed αSyn-

positive inclusions (22). A small portion of its pool can be secreted by neurons and spread to 

neighbouring cells via several mechanisms, such as exocytosis and direct cell-to-cell transfer 

(51,52). Cell-to-cell propagation of αSyn may occur when αSyn is released into the extracellular 

milieu from a dying cell or released from a viable cell that is burdened with αSyn. Small quantities 

of αSyn are similarly released from neuronal cells by unconventional exocytosis, and extracellular 

αSyn contributes to various brain pathologies, such as neurodegeneration and inflammation (53). 

Extracellular αSyn levels have been demonstrated to be regulated by neuronal activity (54). In 

addition, aggregated forms of extracellular αSyn trigger trans-cellular spreading of αSyn 

pathology and extracellular αSyn oligomers activate inflammatory responses in microglia (55–

59). In particular, secreted monomeric αSyn has been shown to display toxicity to cells, perturb 
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calcium homeostasis and induce fragmentation of lipid rafts (60–62). Overall, αSyn plays a 

versatile role in modulating synaptic homeostasis and loss-of-function of the native protein, 

originating from protein misfolding and/or aggregation, and extracellularly available αSyn may 

contribute to synaptic dysfunction and progression in PD. 
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Figure 1. Mechanisms of αSyn aggregation.  

(A) The primary sequence of αSyn with three regions, each displaying unique properties. (B) It is 
believed that αSyn participates in a multi-step process wherein an unfolded monomer undergoes 
primary nucleation and self-assemble to form soluble oligomeric intermediates. During 
elongation, addition of monomers to existing oligomers can lead to the formation of highly 
organized structures, such as protofibrils and fibrils. Fibrils may further form nucleation centers 
and provide autocatalytic amyloid amplification and contribute to the rapid generation of new 
aggregates or further assemble into Lewy bodies in a process known as secondary nucleation. 
Ultimately, synaptic accumulation of aggregated and misfolded αSyn results in synaptic 
impairments, and aberrant neural network activity, leading to cell death. Adapted from 
Saramowicz et al. (2024). Figure was created with BioRender.com. 
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1.3 Microglia in the CNS 

Microglia are the resident immune cells of the CNS and represent the largest population 

of myeloid cells in the CNS (63). They constitute about 10-15% of cells found within the brain 

(64). As the essential macrophages of the brain parenchyma, microglia play a fundamental role 

in the innate immune response and are critical in the maintenance of CNS homeostasis, 

neurogenesis, synaptic plasticity maintenance, synaptic pruning, neural circuit shaping, injury 

repair and overall brain health (65). During CNS injury, microglia are responsible for phagocytosis 

and elimination of microbes, dead cells, and protein aggregates, in addition to other particulate 

and soluble antigens that may compromise the CNS. Furthermore, microglia secrete several 

soluble factors, such as cytokines, chemoattractants, and neurotropic factors, that contribute to 

various aspects of neuroprotective responses and tissue repair in the CNS (65). Microglia have 

demonstrated to jointly degrade fibrillar αSyn cargo by transferring it through tunneling 

nanotubes, attenuating the inflammatory microglia profile (66). More recently, αSyn and tau 

have been shown to engage as triggers tunneling nanotube formation between microglia and 

neurons, facilitating their relocation from aggregate-burdened neurons into healthy microglia 

and rescue neurons from aggregate-induced neuronal dysfunction and death (67). 

Microglial cells encompass a high level of plasticity and manifest a phenotypical 

heterogeneity, undergoing a variety of morphological changes in response to perturbations 

(Figure 2) (68). Microglial morphological plasticity contributes to many developmental processes 

and physiological functions of the brain by adopting a specific phenotype. As such, microglia of 

diverse phenotypes have been classified based on their morphological features. In the healthy 

brain, microglia are in a “surveillant” or “resting” state and appear morphologically ramified with 
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small cell bodies and fine, long branched processes (69). Surveillant microglia are involved in the 

monitoring of potential danger molecules and continuously scan the brain microenvironment for 

extracellular triggers by extending and retracting their processes (70,71). Hence, it may be 

incorrect to refer to microglia as “resting” under physiological conditions, because ramified 

microglia are actively scanning the brain microenvironment and perform many functions during 

normal physiological conditions. The branches of microglia are extremely sensitive to minor 

changes in environmental conditions and microglia may be transformed at any occasion in 

response to injury or threat (72). In comparison, activated microglia mounting an immune 

response transform into an “amoeboid” phenotype, where such cells are spherical in shape, lack 

abundant and long processes, are capable of migration, and contain numerous phagocytic 

vacuoles (73). It is important to note that the bulk of our knowledge concerning microglial 

physiology has been attained using in vitro microglial cultures and due to their extreme 

sensitivity, cell isolation from the tissue inevitably triggers physical alteration-induced, microglial 

activation. Thus, the activation state of microglial cells should always be considered during in 

vitro experimentation. Most importantly, morphology does not reliably signify function or 

dysfunction, however only demonstrates that the cell is responding to altered homeostasis (74).  

In addition to the neuroprotective functions exerted by microglia, they may perform 

neurotoxic roles due to excessive uptake of protein aggregates, leading to microglial phagocytic 

ability impairment, altered inflammation signaling, and thus, potentially contributing to 

neurodegeneration (75). In response to CNS injury and disease, microglia undergo activation. 

Histopathological evidence has demonstrated activated microglia surrounding αSyn deposition 

in the brain tissues from PD patients, such as in midbrain sections of the SNpc, where they display 
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a higher proportion of the amoeboid morphology, suggesting an activated state (76,77). Of note, 

the SN, a susceptible brain region in PD, contains the highest density of microglia among different 

brain regions (78–80). Furthermore, microglial activation begins early and persists during PD 

progression, as it has been observed in patients with a recent diagnosis and in individuals with 

long-term illnesses (81,82). Longitudinal characterization of PD models and extensive analysis of 

human PD brain tissue have revealed that microgliosis may occur prior to neuronal cell death or 

even in its absence, suggesting that the immune response occurs early in PD and changes 

dynamically with disease progression, contributing to neuronal degeneration and 

symptomatology in patients (83,84). These findings have also been validated by in vivo positron 

emission tomography imaging (82,85). In PD, reactive microgliosis can be observed in brain 

regions with substantial αSyn pathology (86). During CNS surveillance, internalization of αSyn can 

induce microglial activation and neuroinflammation (87,88). Different aggregation and 

conformational states of αSyn have revealed to differentially activate microglia in PD with varying 

strengths of activation, leading to increased secretion of pro-inflammatory cytokines and reactive 

oxygen species (ROS) (8,18,89). Likewise, when combined with chronic inflammatory cues, 

PD‑derived αSyn assemblies have demonstrated to promote a neurotoxic microglial phenotype 

(90).  

There are several ways by which uptake of αSyn by microglia mediates αSyn-induced 

inflammation. Microglia are able to phagocytose extracellular monomeric and fibrillar αSyn via 

toll-like receptors (TLRs), an important family of pattern recognition receptors (PRRs) that detect 

pathogens, such as TLR2 and TLR4 (91,92). Moreover, microglia have been shown to engulf 

exosomes containing αSyn via macropinocytosis, where microglial exosomes can facilitate αSyn 
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transmission (93,94). Finally, neurotoxic molecules released from αSyn-activated microglia, 

including pro-inflammatory cytokines, chemokines, glutamate and ROS, may initiate or 

exacerbate neurodegeneration and induce an imbalance in the homeostatic functions of 

microglia, leading to a feedback cycle of microglial activation and neurodegeneration (Figure 2). 
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Figure 2. The morphological heterogeneity of microglia in different environments. 

Microglia are composed of phenotypical plasticity, allowing them to change morphology 
depending on the surrounding environment. For instance, microglia in their homeostatic state 
are considered to be neuroprotective and anti-inflammatory by releasing neurotrophic factors, 
undergoing phagocytosis, and clearing cellular debris in response to acute CNS injury. In 
comparison, microglia can become neurotoxic and pro-inflammatory upon an inflammatory 
stimulus and chronic activation of microglia. As a result, microglia may release pro-inflammatory 
cytokines, produce tissue inflammation and cell death, negatively impacting neurons and 
surrounding cells. The changes observed in phenotype may or may not be reflective of the 
functional state. Figure was created with BioRender.com.  
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1.4 The NLRP3 inflammasome 

The innate immune system acts as the first line of defense that protects the CNS against 

harmful stimuli, for instance invading pathogens, dead cells, or irritants (95). Inflammation is a 

protective immune response displayed by the evolutionarily conserved innate immune system 

that is tightly regulated by the host. Inadequate inflammation may lead to persistent infection of 

pathogens, while excessive inflammation may trigger chronic or systemic inflammatory diseases 

(96,97). In the past two decades, it has been increasingly recognized that the immune system and 

inflammatory processes are implicated in a wide-ranging list of mental and physical health 

difficulties that dominate present-day morbidity and mortality worldwide (98–101). In fact, 

chronic inflammatory diseases have been recognized as the most significant cause of death in 

the world today, with more than 50% of all deaths being attributable to inflammation-related 

diseases (102). 

Inflammasomes are innate immune system receptors and sensors that regulate the 

activation of caspase-1 and produce inflammation in response to detrimental stimuli (103). They 

are cytosolic, multiprotein signalling complexes that respond to pathogen-associated molecular 

patterns (PAMPs) and damage-associated molecular patterns (DAMPs) in a PRR-dependent 

manner. PAMPs are only associated with foreign pathogens, whereas DAMPs are endogenous 

danger molecules that are released upon cellular stress, tissue damage and cell death (104). 

Nucleotide-binding oligomerization domain (NOD)-like receptors (NLRs) are a subset of 

cytoplasmic PRRs that can cooperate with TLRs and drive inflammasome formation (105). Both 

receptor families are expressed in resident CNS cells that participate in innate immunity; 

however, microglia, myeloid cells of the CNS, express all TLRs (106). In comparison, a more 
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restricted group is expressed in astrocytes (107,108). The NLR family pyrin domain containing-3 

(NLRP3) inflammasome is the best characterized inflammasome, where it mediates sterile 

neuroinflammation in microglia (109–112). NLRP3 inflammasome activation has been noted in 

both microglia and astrocytes among other cell types, although only the former has been 

reported to express all NLRP3 inflammasome components and substrates (112–114). The NLRP3 

inflammasome is composed of three major components (Figure 3A), namely NLRP3, which serves 

as an intracellular sensor for various PAMPs and DAMPs, the apoptosis-associated speck-like 

protein containing a caspase activation and recruitment domain or CARD domain (ASC) which 

serves as an adaptor protein, and the effector, caspase-1, which carries out the enzymatic 

cleavage of pro-inflammatory cytokines, such as interleukin (IL)-1β and IL-18, and causes 

pyroptosis, a type of lytic cell death (115). Activated caspase-1 results in the cleavage of 

gasdermin D (GSDMD), forming the N-terminal fragment of GSDMD (N-GSDMD), which self-

assembles and creates transmembrane pores, resulting in pyroptosis and facilitation of bioactive 

IL-1β and IL-18 and ASC specks release into the extracellular space (116). 

Assembly of the inflammasome is a key function mediated by the innate immune system 

and relies on homotypic interactions between the component proteins. NLRP3 is an NLR that 

contains a N-terminal pyrin effector domain (PYD), a central, conserved nucleotide-binding and 

oligomerization (NACHT), and a C-terminal leucine-rich repeats (LRR) domain which is involved in 

ligand binding or activator sensing (Figure 3A) (88). During inflammasome assembly, NLRP3 

engages with the N-terminus of ASC via PYD–PYD interactions and the C-terminus of ASC recruits 

pro-caspase-1 via CARD-CARD interactions, resulting in proximity-induced autocatalytic cleavage 

leading to the production of active caspase-1 (95). 
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The activation of the NLRP3 inflammasome involves two steps (Figure 3B): priming (Signal 

1) and activation (Signal 2). The priming step requires a stimulus to activate the transcription 

factor nuclear factor kappa-light-chain-enhancer of activated B cells (NF-κB), such as via the 

bacterial endotoxin lipopolysaccharide (LPS) binding to TLR4, which initiates translocation of NF-

κB from the cytoplasm into the nucleus to induce gene transcription (117,118). Following 

recognition of LPS, engagement of TLR4 at the cell surface leads to the activation of downstream 

signaling cascades mediated by myeloid differentiation primary response gene 88 (MYD88) and 

TIR-domain-containing adapter inducing interferon-β (TRIF)-dependent pathways (119,120). 

Ultimately, TLR4 signalling and activation of NF-κB results in the transcription of NLRP3 and pro-

IL-1β, yet the priming signal by itself is an inefficient secretion stimulus to produce cleaved 

substrates (121).  

After priming, a second signal is required for the assembly and activation of the NLRP3 

inflammasome, which involves numerous molecular and cellular events, including lysosomal 

damage/destabilization, mitochondrial dysfunction and ROS generation, and ion flux (K+ efflux) 

(122). These signals are induced by a diverse collection of unrelated stimuli recognized as NLRP3 

agonists, for instance pore-forming toxins, the presence of nucleic acids, and sensing of fungal, 

bacterial or viral pathogens (123,124). Of importance, the inflammasome may also be activated 

by neurodegeneration-associated molecular patterns (NAMPs), such as misfolded protein 

aggregates (125). One possible mechanism of activation comprises of various PAMPs and DAMPs 

being internalized into the cell via phagocytosis and trafficked to the lysosome, leading to 

lysosomal rupture and intracellular cathepsin B release, thus triggering NLRP3 inflammasome 

activation (126–128). In addition, mitochondrial ROS production was one of the first identified 
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triggers of NLRP3 inflammasome activation (129–131). For instance, fatty acids in a high-fat diet 

have shown to activate the NLRP3 inflammasome in an adenosine monophosphate-activated 

protein kinase–autophagy–ROS-dependent manner (132). Considering the quantity and diversity 

of NLRP3 inflammasome activators, several molecular or cellular events may converge on a 

common pathway that triggers initial or sustained activation. 
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Figure 3. Overview of NLRP3 inflammasome priming and activation in microglia. 

(A) The NLRP3 inflammasome is composed of three components: NLRP3, which serves as an 
intracellular sensor; ASC, which serves as an adaptor protein; and caspase-1, which serves as an 
effector protein. The NLRP3 inflammasome assembles via homotypic PYD-PYD and CARD-CARD 
interactions. (B) NLRP3 inflammasome activation requires two key signals: priming and 
activation. Priming via LPS induces NF-κB-dependent transcription of NLRP3 and pro-IL-1β. 
Inflammasome engagement results in caspase-1 recruitment and proteolytic self-cleavage to its 
mature form. Active caspase-1 may process pro-IL-1β and pro-IL-18 to its mature form, cleave 
GSDMD to induce pyroptotic cell death, and release ASC specks. Figure was created with 
BioRender.com.  
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1.5 The role of the ASC speck in inflammation 

In the preceding decade, an inflammation-based hypothesis has emerged to elucidate the 

mechanism of neurodegenerative disease progression as many therapies targeting protein 

accumulation have been principally unsuccessful (133,134). In this hypothesis, inflammation 

serves as a triggering event early in the disease that contributes to protein misfolding and 

aggregation which supports neuroinflammation in a positive-feedback manner, ultimately 

leading to neuronal cell death. In addition to forming the basic inflammasome complex, NLRP3 

inflammasome activation may also lead to the formation of a dense structure, known as the ASC 

speck, which is ~1 μm in diameter (109,111). The oligomerization of ASC into ASC specks creates 

a host of potential caspase-1 activation sites, thus serving as a signal amplification mechanism 

for inflammasome-mediated cytokine production (135). Post inflammasome activation and 

recruitment of ASC to the oligomerized NLRP3, ASC aggregation remains an ongoing process 

where large helical fibrils are formed via homotypic interactions between its PYD region. Next, 

many ASC fibrils are crosslinked via homotypic interactions on the ASC-CARD region to form a 

dense ASC speck. As a result, the ASC speck recruits pro-caspase-1 to its surface and functions 

via the same mechanism as the basic inflammasome complex, although at a larger scale (109).  

 An increasing number of neurodegenerative disorders and other diseases have been 

linked to protein misfolding and aggregation. The term ‘prion’ refers to the infectious protein 

primarily composed of major prion protein (PrPSc), the pathological aggregated form of the 

cellular prion protein PrPC, that causes prion diseases (136). The term has broadened to describe 

protein aggregates irrespective of their infectivity and share principles governing aggregation and 

propagation, thus referred to as ‘prionoids’ (prion-like). The ASC speck possesses extracellular 
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and prion-like activity as it propagates from a pyroptotic macrophage to another recipient cell 

while preserving its activity. ASC speck formation upon activation of the NLRP3 inflammasome 

has shown to precede cell death (137). In support, NLRP3 inflammasome particles are secreted 

in the extracellular space where they can continue the maturation of caspase-1 in addition to 

within other macrophage cells upon phagocytosis of the particle, amplifying the inflammatory 

response (138). Macrophages can degrade subthreshold amounts of ASC specks during acute 

inflammation, however chronic inflammation could lead to the accumulation of ASC specks, 

further resulting in prolonged, harmful immune responses (139). Thus, the inflammatory effects 

of ASC speck uptake could be concentration-dependent and swayed by the balance between ASC 

speck accumulation vs clearance. Furthermore, ASC speck’s prion-like structure is resistant to 

proteolytic degradation similar to the misfolded protein aggregates observed in PD and 

Alzheimer’s disease (AD), contributing to failed degradation of the inflammasome and ASC speck 

(137). The ASC speck may also act as a scaffold for protein aggregation as ASC specks have been 

reported to have an intrinsic property to co-aggregate cytosolic proteins on their surface through 

non-specific hydrophobic interactions (140). As a result, ASC specks could provide an alternative 

mechanism of antigen cross-presentation and may shape adaptive immunity by skewing T-cell 

immunity via sustaining the production of IL-1 cytokines in the extracellular space (140–142). 

 

1.6 Maturation of the effector protein caspase-1 and release of IL-1β and IL-18 

Caspases are a family of intracellular cysteine proteases that cleave a limited number of 

substrates present following an aspartic acid residue. The role of caspases has been thoroughly 

studied in apoptosis, where they are crucial in executing programmed cell death (143). 
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Nonetheless, many caspases, including caspase-1, caspase-4 and caspase-5, are classified as 

inflammatory and are engaged in the processing and secretion of pro-inflammatory molecules 

(144,145). Caspase-1 was first identified in 1989 and is one of the most common and best studied 

inflammatory caspases that initiates pro-inflammatory responses through the cleavage of 

cytokines, such as IL-1β (144,146). Caspase-1 is present as a zymogen in the cytosol of phagocytic 

cells that can be cleaved into 20 kDa (p20) and 10 kDa (p10) subunits that become part of the 

active enzyme (147). Thus, pro-caspase-1 requires its activation to be functional, which can be 

accomplished through the assembly of an inflammasome complex. Upon NLRP3 inflammasome 

activation, dormant pro-caspase-1 is self-activated by proteolytic cleavage and mature caspase-

1 proteolytically cleaves other proteins in a cascade of events, such as precursors of the 

inflammatory cytokines IL-1β and IL-18 together with the pyroptosis inducer GSDMD, into 

mature, biologically active forms. 

IL-1β and IL-18 are cytokines of the IL-1 family of ligands and important mediators of 

inflammatory diseases (148,149). While there are several biological properties that overlap for 

these cytokines, differences exist. For instance, IL-1β is induced only in response to inflammatory 

stimuli whereas IL-18 is constitutively expressed under homeostasis (150). IL-1β expression is 

induced during stimulation with TLR ligands and other cytokines. Yet, LPS-mediated priming of 

NLRP3 is required for inflammasome activation and subsequent release of both IL-18 and IL-1β 

(151). Furthermore, IL-1β and IL-18 are differentially regulated. Despite being constitutively 

expressed, IL-18 expression was shown to be increased and sustained after stimulation of TLRs, 

whereas IL-1β was induced but not sustained after chronic treatment (152). Mature IL-1β has 

been linked to many immune system-linked responses, including the recruitment of 
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inflammatory cells to the site of infection, whereas IL-18 is involved in host defense against 

infections and regulates both the innate and acquired immune response (153). IL-18 can combine 

with IL-12 and is important for the production of interferon (IFN)-γ and enhancement of the 

cytolytic activity of natural killer (NK) cells and T lymphocytes (CD8+ T cells) (154). In addition, IL-

18 promotes activation and differentiation of T cells (155). 

IL-1β is the most well-characterised and studied of the 11 IL-1 family members. IL-1β is 

essential for the host-response and resistance to pathogens but also exacerbates damage during 

chronic disease processes and is linked to acute tissue injury (107). Following caspase-1-

dependent processing of pro-IL-1β, it has been proposed that the secretion of IL-1β occurs on a 

continuum, dependent upon stimulus strength and the extracellular IL-1β requirement (156). 

Rather than the conventional endoplasmic reticulum-Golgi route of secretion, IL-1β may be 

secreted via three distinct mechanisms (156). For instance, the rescue and direct mechanism 

suggests that a fraction of cellular IL-1β that is targeted for degradation can be rescued and 

redirected to the extracellular environment and such a mechanism will likely be engaged when 

the extracellular requirement for IL-1β and commitment to cell death is low. It has been 

demonstrated that the majority of IL-1β in LPS-activated monocytes localizes to the cytosol, 

although a portion of IL-1β can be present in vesicles and is protected from tryptic digestion 

(157,158). Furthermore, IL-1β may be secreted via a protected release since IL-1β has a very short 

half-life in plasma and supports the notion that protected IL-1β is destined for sites distant to the 

inflammatory lesion (159). Protected release of IL-1β may be secreted via the shedding of 

microvesicles from the plasma membrane and in support, IL-1β-containing microvesicles have 

been isolated from LPS-treated microglia (160,161). Exosomes, which are membrane-bound 
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extracellular vesicles, have also shown to package and secrete IL-1β in a protected form (162). 

Lastly, the terminal release mechanism involves a commitment to cell death, such as pyroptosis, 

and may occur under conditions of extreme inflammatory stress. This mechanism appears to be 

well-equipped for the rapid release of large quantities of active IL-1β directly across a 

disintegrating plasma membrane. It has been demonstrated that a 30 minute (min) incubation 

with adenosine triphosphate (ATP), a NLRP3 inflammasome inducer, triggers LPS-primed murine 

peritoneal macrophages to swell, which is closely followed by the release of lactate 

dehydrogenase (LDH), a cytosolic enzyme released from lytic cells (163). However, cell lysis as 

such does not automatically induce release of active IL-1β, since LPS-treated murine peritoneal 

macrophages primarily release pro-IL-1β when subjected to oxidative injury (164). 

Compared to the release of IL-1β, mechanisms supporting the release of IL-18 are less 

well understood. Despite distinct regulatory mechanisms that control the pro-inflammatory 

cytokines IL-1β and IL-18, both share a common secretory pathway that depends upon 

membrane permeability and can operate in the absence of complete cell lysis and cell death 

(165). In primary human monocyte-derived macrophage cultures primed with LPS and stimulated 

with nigericin, both IL-1β and IL-18 were released. In both instances, release was inhibited by a 

pre-incubation with the membrane-stabilizing agent punicalagin (165). In comparison, blocking 

cell lysis with a cytoprotectant, such as glycine, did not inhibit NLRP3-dependent release of IL-1β. 

Together, these findings suggest that IL-1β and IL-18 share a common secretory pathway that 

depends upon membrane permeability and further supports the well-accepted notion that 

release of IL-1β and IL-18 can be GSDMD-dependent. 
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1.7 Induction of pyroptosis 

Active cell death is a fundamental biological process that is tightly regulated and serves 

to assist host defense (166). However, chronic activation of cell death pathways in response to 

PAMPs or DAMPs can lead directly to the development of neuroinflammation and pathology. 

Thus, distinct forms of regulated cell death have been classified as key drivers of CNS diseases, 

such as apoptosis, necrosis, and pyroptosis (167). Most notably, apoptosis, the primary form of 

programmed cell death, has been well defined and extensively researched (168). Apoptosis has 

been demonstrated to underlie mechanisms of physiological CNS development as well as 

common neurological disorders, for instance AD, PD and amyotrophic lateral sclerosis (169–171). 

More recently, an inflammatory cell death referred to as “pyroptosis” has been identified as a 

key mediator of inflammatory responses and instigator of different forms of neurological 

diseases (172–174). 

In 2015, multiple studies discovered GSDMD as an executor of pyroptosis and that 

cleavage of GSDMD by inflammatory caspases determines pyroptotic cell death (116,175). 

GSDMD consists of two conserved domains, the N-terminal pore-forming domain (PFD; also 

referred to as N-GSDMD) and the C-terminal repressor domain (RD) (176,177). GSDMD, along 

with other proteins of the GSDM superfamily, maintain oligomerization through the interaction 

between PFD and RD and RD may inhibit the cytotoxic effects of PFD. Upon NLRP3 inflammasome 

activation and subsequent cleavage of caspase-1, GSDMD is cleaved, and the N-terminal PFD is 

dissociated from the C-terminal RD. Next, the N-terminal PFD oligomerizes and undergoes 

conformational changes and forms pores in the cell membrane, triggering the release of 

inflammatory molecules and pyroptotic cell death (Figure 3B) (178–180). Pore formation in the 
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plasma membrane, which is ~10-33 nm in diameter, allows processed IL-1β and IL-18, with 

diameters of 4.5 nm and 7.5 nm, respectively,  as well as caspase-1 to pass through and be 

released into the extracellular milieu (178,179,181). Lastly, plasma membrane rupture, the final 

cataclysmic event in lytic cell death, is mediated by the cell-surface NINJ1 protein (182). NINJ1 

mediates plasma membrane rupture downstream of various cell death processes, where plasma 

membrane rupture releases DAMPs that propagate the inflammatory response. 

In addition to the canonical inflammasome-dependent pathway mediated by caspase-1, 

non-canonical inflammasome-dependent pathways may also induce pyroptosis. Caspase-4/5/11 

can be directly activated by LPS in host immune cells, leading to GSDMD cleavage, though 

caspase-4/5/11 cannot process pro-IL-1β and pro-IL-18 (183). K+ efflux via pore formation further 

promotes the activation of caspase-1 (184,185). Moreover, pyroptosis can be activated in an 

inflammasome-independent manner. Activation of caspase-3, an apoptotic caspase, has also 

proven to promote microglial pyroptosis in models of multiple sclerosis via cleavage of GSDME 

(186). Despite some similarities between pyroptosis and apoptosis, for instance DNA damage and 

chromatin condensation, several key differences exist (174). Morphologically, pyroptotic cells 

display cell swelling and many bubble-like protrusions on the surface of the cellular membrane 

before its rupture and are inflammatory in nature (187). As a result of the pore formation, water 

enters the cell, causing cell swelling and osmotic lysis, resulting in rupture of the plasma 

membrane and the release of IL-1β and IL-18 (188,189). Pyroptosis can also appear as flattening 

of the cytoplasm due to plasma membrane leakage (187). In contrast, apoptotic cells shrink and 

maintain membrane integrity in the absence of GSDMD cleavage and pore formation (190). 
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Overall, pyroptosis has been increasingly recognized as an important factor in mediating 

inflammatory responses against PAMPs and DAMPs. 

 
 

1.8 Contribution of the NLRP3 inflammasome to neuroinflammation and 

neurodegeneration 

The underlying molecular pathogenesis of PD is thought to involve multiple pathways and 

mechanisms, for example αSyn proteostasis, mitochondrial function, oxidative stress, calcium 

homeostasis, axonal transport and neuroinflammation (1). Neuroinflammation in the PD brain is 

mediated by activated microglia and invading immune cells (191). Increasing evidence indicates 

that activation of the microglial NLRP3 inflammasome by aggregated Aβ, tau and αSyn results in 

the release of IL-1β and IL-18, leading to chronic neuroinflammation and disease progression 

both in AD and PD (192–195). During neuroinflammation, activated microglia release the 

inflammasome adaptor protein ASC outside the cell as ASC specks which can act as a ‘danger 

signal’. The extracellular ASC is biologically active and cross-seeds Alzheimer’s-linked Aβ in 

neighbouring microglia (196). More recently, extracellular ASC has been shown to bind Aβ and 

internalization of ASC-Aβ complexes by microglia results in NLRP3 inflammasome activation and 

pyroptotic cell death. This further leads to the amplification and perpetuation of pro-

inflammatory responses in a molecular feed-forward vicious cycle that can lead to neuronal 

damage (193). In addition, clustering around ASC fibrils also compromises clearance of Aβ by 

microglia.  

Studies on human samples and preclinical animal models of PD have established a link 

between αSyn aggregation, microglial NLRP3 inflammasome activation and neuronal cell death 
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(197). PD patients have increased NLRP3, ASC, and caspase-1 localized exclusively within 

microglia in the SNpc or detectable as extracellular ASC and systemically circulating NLRP3, 

caspase-1, and IL-1β (197,198). Furthermore, caspase-1 can also be discovered at the core of 

Lewy bodies extracted from human PD patients’ brains (199). Recently, it was revealed that ASC 

specks amplified NLRP3 inflammasome activation driven by αSyn pre-formed fibrils (PFFs) and 

reactive microgliosis, exacerbating αSyn pathology, dopaminergic neurodegeneration and motor 

deficits (200). However, the contribution of ASC specks and its interaction with αSyn in the 

propagation of inflammasome activation and amplification of inflammatory responses in PD has 

not been fully determined. Numerous therapeutics have only targeted protein accumulation in 

PD and other neurodegenerative diseases, failing to consider other etiologies. Hence, this 

therapeutic strategy has likely contributed to a significant failure rate in translating pre-clinical 

studies of clinical value. The recent failures in the development of antibody-based therapeutics 

against aggregated αSyn for PD treatment have prompted a re-evaluation of the existing 

therapeutic strategies and justify the need for alternative strategies targeting microglial immune 

responses (201,202). One of the greatest current challenges is to identify markers for prodromal 

disease stages, which would allow novel disease-modifying therapies to be started earlier. 

Therefore, it is critical to comprehend neuroinflammation in PD and develop therapeutic 

strategies to prevent further neuron loss and halt PD progression.  
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2. HYPOTHESIS AND OBJECTIVES 

2.1 Hypothesis 

I hypothesize that binding of αSyn to ASC in the extracellular space of the brain leads to 

the formation of ‘ASC-αSyn complexes’, which are recognized as novel danger signals by microglia 

leading to NLRP3 inflammasome activation and amplification of the pro-inflammatory response 

(Figure 4).  

 

2.2 Objectives 

The objective of this study was to gain insight into the underlying molecular mechanisms 

that perpetuate chronic inflammatory responses in PD models. The aims of this project were to 

1) develop and characterize ASC-αSyn complexes; and 2) study the effects of ASC-αSyn complex 

formation on NLRP3 inflammasome activation in murine microglia using an in vitro model.  
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Figure 4. Schematic showing proposed mechanisms of microglial activation and chronic 
neuroinflammation. 

Binding of ASC to αSyn in the extracellular milieu can result in the formation of ASC-αSyn 
complexes that are phagocytosed by surveillant microglia and can further amplify NLRP3 
inflammasome activity. Sustained exposure of microglia to ASC-αSyn complexes may trigger 
pyroptosis, an inflammatory form of cell death and release more bioactive ASC which can be 
incorporated into the microglial inflammasome, leading to a vicious cycle of NLRP3 activation and 
neuroinflammation. Neuronal exposure to ASC-αSyn complexes may negatively impact neuronal 
health. Figure was created with BioRender.com.  
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3. MATERIALS AND METHODS 

3.1 Cell culture  

Mouse SIM-A9 microglia (ATCC; Cat# CRL-3265) were cultured in Dulbecco’s modified 

Eagle’s medium/Ham’s F12 50/50 Mix (DMEM/F12) (Wisent; Cat# 319-075-CL) containing 10% 

heat-inactivated Qualified Fetal Bovine Serum (FBS) (Gibco; Cat# 12483-020) under standard 

conditions at 37C and 5% CO2. Cells were passaged every two to three days in T25 and T75 

culture flasks. Cells between passage 16 to 30 were used for all experiments. 

 

3.2 Preparation of recombinant ASC 

Recombinant human ASC protein was produced by expression of ASC in E. coli BL21 cells. 

For expression, cultures were induced O/N at 28°C with 10 µM isopropyl β-D-1-

thiogalactopyranoside (IPTG) and cells were lysed by sonication and centrifuged to fractionate 

the lysed preparation into pellet (insoluble protein) and supernatant (soluble protein). Proteins 

were expressed in high yields, almost exclusively in insoluble inclusion body forms. ASC protein 

from the insoluble inclusion body fraction was solubilized in 8 M urea and refolded by employing 

standard protocols (203). Refolded soluble ASC in 20 mM Tris/HCl 0.5 M L-arginine, 10 mM 

cystamine, and 1 mM cysteamine (pH 11) was purified by size-exclusion chromatography (SEC).  

To induce fibrillation, the ASC-containing solution was first buffer exchanged to cold 

phosphate buffered saline (PBS) (Wisent; Cat# 311-010-CL) using an Amicon® Ultra 0.5mL 

Centrifugal Filter (10 kDa MWCO) (Millipore; Cat# UFC501024) for 10 min at 12,000 x g at 4°C (3x 

washes). Everything was kept cold and a filter volume of >100 µL was maintained. ASC was 
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transferred to LoBind Tubes (Eppendorf; Cat# 022431081) and ice-cold PBS was added until the 

desired concentration was reached. The final concentration of ASC was quantified by NanoDrop 

using the extinction coefficient ε = 30.94 and was incubated for 1 h at 37°C, as described 

previously (193). ASC fibrils were kept at 4°C for no longer than 2-3 days. 

 

3.3 Preparation of αSyn, Aβ, and bovine serum albumin 

Human Recombinant αSyn Protein Monomers (Type 1) was commercially purchased at a 

stock concentration of 5 mg/ml in PBS (pH 7.4) (StressMarq Biosciences Inc.; Cat# SPR-321) and 

stored at -80C. As a working concentration, 2.5 and 5 M was used for in vitro treatments. 

During preparation of working stocks, αSyn monomers were always on ice or at 4C. Monomers 

may start to aggregate if left at RT or 37C for prolonged amounts of time. αSyn monomers were 

used up to a maximum of two freeze/thaw cycles. 

Aβ protein (1-42), specifically 1,1,1,3,3,3-Hexafluoro-2-propanol (HFIP)-treated (Bachem 

AG; Cat# 4090148), was dissolved in sterile Dulbecco’s phosphate buffered saline (DPBS) (Gibco; 

Cat# 14040141) to create a stock concentration of 0.45 mg/ml and stored at -80C. HFIP is a 

volatile solvent, which disrupts Aβ fibrils and generates monomers by breaking down β-sheet 

structures and disrupting hydrophobic forces in aggregated amyloid preparations (204). As a 

working concentration, 5 M was used for in vitro treatments. During preparation of working 

stocks, Aβ monomers were always on ice or at 4C and were used up to a maximum of two 

freeze/thaw cycles. 
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Bovine Serum Albumin Fraction V (BSA) (Sigma-Aldrich; Cat# 810533) was dissolved in PBS 

to create a stock concentration of 3 mg/ml and stored at -20C. As a working concentration, 5 

M was used for in vitro treatments. 

 

3.4 Generation of ASC-αSyn complexes 

Fibrillar ASC (2.5 µM) and αSyn monomers (2.5 µM) were incubated in DMEM/F12 media 

with 1% FBS and 1% penicillin-streptomycin (P-S) (Wisent; Cat# 450-201-EL) in LoBind Tubes at 

37C, O/N (Figure 5B). The same procedure was applied to single protein treatments containing 

1% FBS and 1% P-S. ASC-Aβ complexes (1.75 µM ASC and 5 µM Aβ) were used as a positive 

control, as previously described (193). ASC-BSA complexes (1.75 µM ASC and 5 µM BSA) were 

used as a negative, non-amyloidogenic control. 

 

3.5 Electron microscopy (EM) 

Fibrillary ASC (1.75 µM) and αSyn monomers (5 µM) were pre-incubated in Tris-buffered 

saline (TBS) (ThermoScientific; Cat# J60877.K2) O/N at 37C, as described above in the 

“Generation of ASC-αSyn Complexes” section. Four to six Carbon Support films (300 mesh grids, 

Copper) (Ted Pella, Inc.; Cat# 01843-F) at a time were placed on a cover glass and glow discharged 

using the PELCO easiGlowTM Glow Discharge System (Ted Pella, Inc.) on auto mode. It is important 

to note the Copper grids require delicate handling during specimen preparation. For negative 

staining EM, 5 µL of the protein sample was applied to a glow discharged copper grid and 

incubated for 2 min at room temperature (RT). Fluids were removed with the aid of a Whatman 

filter paper and samples were negatively stained by adding 5 µL of 2% uranyl acetate onto the 
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copper grid following a 30 second incubation step. Finally, residual fluids were removed using a 

filter paper and the EM grid was air-dried. Samples were imaged using a JEOL JEM-1400Plus TEM 

(120 kv) equipped with a 16MP digital camera (GATAN One View). Images were processed using 

ImageJ (National Institute of Health). 

 

3.6 In vitro treatments 

For in vitro experiments, mouse SIM-A9 microglia were seeded at a density of 5 x 104 

cells/well in 500 µL DMEM/F12 containing 10% FBS in a 24-well plate and allowed to adhere 

overnight (O/N). For inflammasome priming, SIM-A9 microglia were first stimulated with 100 

ng/mL lipopolysaccharide (LPS; from Escherichia coli [O55:B5]) (Sigma; Cat# L6529) for 3 h. 

Following washing the cells once with serum-free DMEM/F12, cells were then treated with either 

2.5 µM ASC, 2.5 µM αSyn, ASC-αSyn complexes (containing 2.5 µM ASC and 2.5 µM αSyn) for 24 

h. After 24 h of treatment, supernatants and cell lysates were collected for various assays. All 

treatments were performed in DMEM/F12 media with 1% FBS and 1% P-S in a final volume of 

200 µL, unless specified otherwise, with a minimum of two technical replicates (Figure 5C). 

 

3.7 Immunocytochemistry (ICC) 

SIM-A9 microglia were seeded at a density of 5 x 104 cells/well in 500 µL DMEM/F12 

media with 10% FBS in a 24-well plate containing 100 µg/mL poly-D-Lysine (PDL)-coated (Sigma-

Aldrich; Cat# A-003-E) coverslips. To confirm the microglial origin of mouse SIM-A9 microglia, 

rabbit anti-Iba-1 (1:500; Fujifilm Wako; Cat# 019-19741), rabbit anti-CD68 (1:100; Abcam; Cat# 

ab303565), mouse anti-MAP2 (1:250; Sigma-Aldrich; Cat# M4403) and rabbit anti-GFAP (1:250; 



 33 

Dako; Cat# Z0334) were used. The remaining immunocytochemical steps were performed as 

described below.  

Treatments were performed as described above in the ‘‘Cell Culture and Treatments’’ 

section. After the treatments, cells were washed once with PBS and fixed in 4% 

paraformaldehyde (PFA) (Biotium; Cat# 22023) dissolved in PBS for 15 min. For permeabilization, 

cells were washed once with PBS and incubated with 0.25% Triton X-100 for 10 min. Thereafter, 

cells were blocked using Dako Protein Block, Serum-Free (Agilent Technologies, Inc.; Cat# X0909) 

for 20 min and without washing, primary antibodies were diluted in Dako Antibody Diluent 

(Agilent Technologies, Inc.; Cat# S0809) and added O/N at 4C in a humidified chamber. To create 

a humidified chamber, a Whatman filter paper was placed inside a large petri dish and PBS was 

added on top until the filter paper absorbs the solution and the dish containing coverslips with 

the primary antibodies was wrapped with parafilm. To visualize activation of the NLRP3 sensor 

and ASC speck formation, the mouse anti-NLRP3/NALP3 (1:100; Cryo-2; AdipoGen; Cat# AG-20B-

0014-C100) and rabbit anti-ASC (1:100; clone AL177; AdipoGen; Cat# AG-25B-0006-C100) was 

used, respectively. After three washing steps in PBS, the secondary antibodies goat anti-mouse 

Alexa Fluor™ 488 (1:500; Invitrogen; Cat# A-11029) or goat anti-rabbit Alexa Fluor™ 488 (1:500; 

Invitrogen; Cat# A-11008) were applied for 30 min followed by three more washing steps. Along 

with the goat anti-rabbit antibody, Phalloidin-iFluor 594 Reagent (Abcam; Cat# ab176757) was 

added at a 1:2,000 ratio to stain actin filaments. Coverslips were quickly rinsed once in dH2O and 

dried perpendicularly on a kimwipe and placed onto a microscope slide. Dako Fluorescent 

Mounting Medium (Agilent Technologies, Inc.; Cat# S3023) spiked with 5 µg/mL Hoechst 33258 

was used to mount the coverslips. 



 34 

To visualize caspase-1 activity, the FAM-FLICA® Caspase-1 (YVAD) Assay Kit 

(ImmunoChemistry Technologies LLC; Cat# 98) was used according to the manufacturer’s 

protocol. A vial of FLICA was reconstituted with 50 µL DMSO to form the 150X stock. Immediately 

prior to addition to the samples and controls, FLICA was diluted 1:5 by adding 200 μL PBS to each 

vial to form the 30X FLICA solution and the 30X FLICA was used within 30 min or stored at ≤-20°C. 

Following treatments, the 24-well plate was centrifuged at 1,500 revolutions per minute (rpm) 

for 5 min and supernatants were collected. 1X FLICA with 1 μg/mL Hoechst 33342 was 

immediately added to the samples and controls and incubated for ~1 h at 37C, mixing gently 

every 10-20 min to disperse the reagent. The cells were centrifuged at 1,500 rpm for 5 min and 

the overlay media containing FAM-FLICA was carefully removed and replaced with 1X Apoptosis 

Wash Buffer. The cells were incubated for 5 min at 37°C to allow any unbound FAM-FLICA to 

diffuse out of cells. The plate was re-centrifuged, and cells were fixed using Fixative at a dilution 

of 1:5 for 20 min at RT in the dark. The fixative was removed, and cells were allowed to dry for 

15 min. The coverslips were briefly submerged in dH2O and dried perpendicularly on tissue paper 

to remove excess dH2O. Cells were mounted with mounting media onto a microscope slide and 

dried for a few min. Cells were viewed immediately with a fluorescence microscope since the 

FAM-FLICA fluorescent signal is not stable O/N.  

All images were captured using Z-stack imaging, with a z-step of 0.8 µm, and with a 20x 

or 63x objective. Every image was imaged from the farthest point to the closest point from the 

objective. All images were acquired using a Leica STELLARIS 5 Confocal Microscope (Leica 

Microsystems). Image processing was accomplished using LAS X Office (Leica Microsystems) and 

image analysis (150-1200 cells per replicate sample; 20x images only) was completed using 
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ImageJ (National Institute of Health). The total number of cells and NLRP3 mean fluorescence 

intensity was performed using automated counting, whereas the number of ASC specks and 

active caspase-1 cells were completed via manual counting and marking. The protocols for each 

analysis method are as follows (modified from the protocol available online from Christine Labno, 

University of Chicago, Integrated Light Microscopy Core): 

 

Automated counting 

1) Import or open the image to be counted with ImageJ. The colour image (red, green and 

blue; RGB) will have to be converted to greyscale before proceeding. Check that you have 

set Edit → Options → Conversions to “scale when converting.” Then use Image → Type 

→ 16-bit to convert to greyscale. 

2) Once the image is in greyscale, adjust the threshold to highlight all the cells you want to 

count. Use Image → Adjust → Threshold. Check the option “Dark background” and 

change the colour to “Red”. Use the slider to highlight the cells red and until all the 

foreground is red in a dark background. Click “Apply” and close the Threshold window. 

3) To convert the image into a binary image, use Process → Binary → Make Binary. 

4) To convert grouped or clustered cells into single cells, use Process → Binary → 

Watershed. The software will add a 1-pixel thick line where it feels the division between 

cells should be.  

5) To count the number of cells, use Analyze → Analyze Particles. Change the size to “200 – 

25000” and check the “Pixel units” box. Adjust the size range if too many small “noise” 

pixels are being counted as pixels, or if you wish to exclude particles based on size. 
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Circularity excludes particles based on how close to perfectly round they are. Change the 

circularity to “0.4 – 1.0”. To include or exclude particles, adjust these numbers, 

considering that 0.00 is a straight line and 1.00 is a perfect circle. In the “Show” dropdown, 

select “Outlines” to count the number of all particles. Check the “Summarize” and 

“Exclude on edges” boxes and click OK.  

6) To continue the analysis and measure the fluorescence intensity of the cells, select the 

particles to be analyzed by retrieving the watershed image and use Analyze → Measure. 

Re-use Analyze → Analyze Particles and check the “Add to Manager” box and click OK. 

The cells from the watershed image will now be converted into numbered cells. The area 

and intensity will be assigned to the specific cell number.  

7) Next, use Analyze → Set Measurements. Check the “Area” and “Mean gray value” boxes 

and click OK. 

8) Import the original, unthresholded image into the software and open the ROI Manager 

window. Check the “Show All” and “Labels” boxes. 

9) To measure the area and intensity of all the cells, hold down the Shift key and select the 

first ROI. Without releasing the Shift key, scroll down to the last ROI and select the last 

ROI. All the ROIs will be selected and click Measure. The Results window will display the 

area and mean of each particle. Use Results → Summarize. The mean fluorescence 

intensity of all the cells in the image will be calculated, including the minimum and 

maximum intensity of a particle. 
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Manual cell counting and marking  

1) To manually count/mark ASC specks and active caspase-1 cells, install the Cell Counter 

plugin, which is widely available on the internet upon a quick search.  

2) Import or open the image to be counted with ImageJ. Compared to the “Automated 

counting” protocol above, the colour image (RGB) does not have to be converted to 

greyscale. Colour images are preferred to ensure an accurate analysis. 

3) Use Plugins → Cell Counter and a cell counter window will open, where next to each type 

of count, a tally will be kept.  

4)  To start counting, click “Initialize” and a counter window will open. Select a type of 

counter and begin counting. 

5) Use Results → Save to save your counts as Excel formatted files. 

 

3.8 Protein quantification 

To determine the protein concentration of cell lysates used for immunoblotting, a DC 

(detergent compatible) Protein assay was performed (Bio-Rad) according to the manufacturer’s 

microplate assay protocol. The working reagent was prepared as needed, adding 20 µL of reagent 

S to each mL of reagent A, and five dilutions of a BSA protein standard containing from 0.2 mg/mL 

to 1 mg/mL protein. The absorbance was measured at 750 nm with a standard laboratory 

spectrophotometer.  

To determine the protein concentration of cell lysates used for Simple Western 

immunoassays, a QuantiProTM bicinchoninic acid (BCA) assay (Sigma; Cat# QPBCA) was 

performed according to the manufacturer’s instructions using 96-well plate format (Becton 
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Dickinson; Cat# 351172). Two µL of lysate was added to 150 µL of MilliQ water (mQH2O) in wells 

of a 96-well plate, then 150 µL of BCA reagent, prepared according to the manufacturer’s 

instructions, was added with gentle mixing by pipetting. The plate was incubated at 60°C for 1 h 

in a Shel-Lab 1300U oven and cooled to RT. The absorbance was measured at 560 nm with a 

microplate reader and compared to BSA standards (0.5-20 µg/mL) prepared in mQH2O from a 50 

µg/mL stock. 

 

3.9 Immunoblotting (IB)  

To confirm the purity of human recombinant ASC and αSyn monomers and formation of 

ASC oligomers, they were subjected to sodium dodecyl sulfate–polyacrylamide gel 

electrophoresis (SDS-PAGE) and western blot analysis. To identify molecular masses of ASC and 

αSyn, primary antibodies against rabbit ASC (1:1,000; AdipoGen; Cat# AG-25B-0006-C100) and 

mouse αSyn (1:1,000; Abcam; Cat# ab27766), respectively, were used. The remaining steps were 

performed as described below.  

Mouse SIM-A9 microglia were seeded at a density of 2.2 x 105 cells/well in 2 mL 

DMEM/F12 containing 10% FBS in a 6-well plate and allowed to adhere O/N. Following 

inflammasome priming with 100 ng/mL LPS for 3 h, cells were treated as described in the ‘‘Cell 

Culture and Treatments’’ section above. Treatments were performed in DMEM/F12 media with 

1% FBS and 1% P-S in a final volume of 1 mL. Cell lysates were subjected to western blot analysis 

to determine the protein levels of NLRP3, ASC, full-length and cleaved caspase-1, and full-length 

and cleaved GSDMD, in cell lysates. For lysate collection, cells were scraped off the well plate in 

PBS, centrifuged at 3,000 rpm for 5 min at 4°C and pellets were lysed on ice using 1X 
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radioimmunoprecipitation buffer (RIPA) buffer (Sigma; Cat# R0278) supplemented with freshly 

added 1X Protease/Phosphatase Inhibitor Cocktail (PI) (ThermoScientific; Cat# 1861280). Cell 

lysates were denatured in 4x LaemmLi Sample Buffer (Bio-Rad; Cat# 1610747) for 5 min at 95°C. 

Proteins at 20, 30, and 40 μg were separated on a 4-20% Mini-PROTEAN TGXTM SDS–

polyacrylamide Precast gel (Bio-Rad; Cat# 4561093) at 140V for ~1 h in 1x Tris/Glycine/SDS Buffer 

(Bio-Rad; Cat No.: 1610732) and transferred to 0.2 µm polyvinylidene difluoride (PVDF) 

membranes (Bio-Rad; Cat# 1620177) at 100V for 1 h in 1x Tris/Glycine Buffer (Bio-Rad; Cat No.: 

1610734). After the transfer and before blocking, PVDF membranes were incubated with 

Ponceau S Staining Solution (ThermoScientific; Cat# A40000279) for 15 min at RT with gentle 

agitation to help quantify the protein transfer and allow for standardization of protein loading 

between lanes. The membrane was carefully washed in ultrapure water for 30–90 seconds or 

until the desired staining intensity was achieved. The blot was imaged using the Ponceau S 

imaging function and the membrane was de-stained by washing with TBS containing Tween (TBS-

T; ThermoScientific; Cat# 28360) until all the “red” stain was removed. Membranes were then 

blocked with TBS-T in 5% non-fat dry milk (Bio-Rad; Cat# 1706404) for 1 h at RT. Post-blocking, 

membranes were processed and incubated O/N at 4°C with primary antibodies against mouse 

NLRP3 (AdipoGen; Cat# AG-20B-0014-C100), rabbit ASC (AdipoGen; Cat# AG-25B-0006-C100), 

mouse caspase-1 (Adipogen; Cat# AG-20B-0042), and rabbit GSDMD (Abcam; Cat# ab209845) at 

a 1:1,000 dilution in TBS-T in 5% non-fat dry milk. The membranes were washed 3 times for 10 

min each in TBS-T on a horizontal shaker and later incubated with goat anti-rabbit (1:10,000; 

Sigma; Cat# A0545) and rabbit anti-mouse (1:7,500; Sigma; Cat# A9044) horseradish peroxidase 

(HRP)–conjugated secondary antibodies in TBS-T containing 5% non-fat dry milk. The membranes 
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were again washed 3 times for 10 min each in TBS-T. Immunoreactive proteins were visualized 

by the addition of SuperSignal™ West Pico PLUS Chemiluminescent Substrate (ThermoScientific; 

Cat# 34577) for 5 min and were imaged with the ChemiDocTM Imaging System (Bio-Rad). 

Densitometric, semi-quantitative analysis of immunoblots was performed using ImageLab 

software (Bio-Rad). Band intensity measurements obtained from proteins of interest were 

normalized to the Ponceau S stain (total lane protein) and divided by the untreated control (UT 

ctrl) and graphically displayed as fold changes. 

 

3.10 Simple Western immunoassay and Wes-based visualization of protein 

electrophoresis 

Simple Western analysis was performed on a Wes instrument (ProteinSimple; Cat# 004–

600) according to the manufacturer’s instructions using a 12–230 kDa Separation Module 

(ProteinSimple; Cat# SM-W001) under reducing and denaturing conditions and the Anti-Rabbit 

Detection Module (ProteinSimple; Cat# DM-001) or the Anti-Mouse Detection Module 

(ProteinSimple; Cat# DM-002), depending on the primary antibody used.  

Cell pellets were collected as mentioned in the ‘‘Immunoblotting” section above. One 

hundred µL of 1X RIPA buffer with 1X PI was added to each cell pellet on ice and the lysate was 

incubated on ice for 30 min. Lysates were later centrifuged at 21,000 x g for 10 min at 4C. 

Samples were diluted to a concentration of 0.5 μg/mL (which results in a loading amount of 0.5 

μg of total protein per capillary) in 0.1X sample buffer (ProteinSimple; Cat# 042-195), then mixed 

with Master Mix (ProteinSimple; Cat# PS-ST03) at a 1:4 ratio (1 µL of Master Mix and 4 µL of 

sample) and heated at 95°C for 5 min. Samples were cooled to RT, vortexed to mix and 
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centrifuged in a Mandel mini microfuge. Five µL of biotinylated ladder (ProteinSimple; Cat# PS-

ST01-8) was loaded in the first well of row A1. Three µL of samples were loaded in the remaining 

wells of row A. Ten µL of antibody diluent (ProteinSimple; Cat# 042-203) was added to row B and 

the first well of row C. Primary antibodies against mouse, rabbit ASC, mouse caspase-1, and rabbit 

GSDMD were diluted with antibody diluent at a 1:100 dilution and added to the remaining wells 

of row C. Ten µL of streptavidin-HRP (ProteinSimple; Cat# 042-414) was added to the first well of 

row D. Secondary antibodies were added to the other wells of row D. Luminol (ProteinSimple; 

Cat# 043-311) and peroxide (ProteinSimple; Cat# 043-379) were mixed (200 µL of each) and 15 

µL was added to each well of row E. The plate (ProteinSimple; Cat# SM-W004-1) was covered 

with a lid and centrifuged at 1,200 x g for 10 min in an Eppendorf 5810R centrifuge. Five hundred 

µL of wash buffer (ProteinSimple; Cat# 042-202) was added to three rows of wells on the plate. 

The foil was removed from the separation reagents and the plate and capillaries (ProteinSimple; 

Cat# SM-W008-1) were placed in Wes. Wes was run according to the following protocol (Table 

1): separation at 375 V for 28 min; blocking reagent for 5 min, primary and secondary antibody 

for 30 and 60 min, respectively; Luminol/peroxide chemiluminescence detection for ~15 min 

(exposures of 1-2-4-8-16-32-64-128-512 seconds). Anti-actin-HRP (Sigma; Cat# A3854) was used 

as a protein loading control (1:500 dilution in antibody diluent).  

The resulting electropherograms were inspected to check whether automatic peak 

detection required any manual correction. Automatically detected peaks were quantified by 

calculation of the area under the curve. Band intensity measurements obtained from proteins of 

interest were normalized to actin from its respective lane and divided by the UT ctrl and 
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graphically displayed as fold changes. Quantitative data analysis and generation of figures were 

performed using the Compass for Simple Western Software (ProteinSimple). 
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Table 1. Workflow of the Simple Western procedure including time to complete a Wes run. 
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3.11 Measurement of cytokine and chemokine concentrations 

Following treatment of SIM-A9 microglia, cell supernatants were collected and IL-1β and 

IL-18 levels were measured using the mouse IL-1β (R&D Systems; Cat# DY401-05) and IL-18 (R&D 

Systems; Cat# DY7625-05) enzyme-linked immunosorbent assays (ELISAs), respectively. ELISAs 

were performed according to the manufacturer’s protocols in Immulon 4 HBX Flat Bottom Plates 

(ThermoScientific; Cat# 3855). TMB (3, 3′, 5, 5′-tetramethylbenzidine) ELISA Substrate (High 

Sensitivity) (Abcam; Cat# ab171523) was added for 7 min and the reaction was terminated by 

adding 2 N H2SO4. The absorbance was measured at 450 nm with a microplate reader. Readings 

at 540 nm were subtracted from the readings at 450 nm. 

The MILLIPLEX® Mouse Cytokine/Chemokine Magnetic Bead Panel (Millipore; 

MCYTOMAG-70K) was used to measure the secretion of several cytokines and chemokines, 

including IL-1α, IL-1β, IL-4, IL-6, IL-10, IP-10, KC, MCP-1, MIP-2, RANTES, and TNF-α. The assay 

was performed according to the manufacturer’s protocols. One hundred and fifty L of Drive 

Fluid PLUS was added to all wells and the plate was run on a MAGPIX® instrument with xPONENT® 

software. The Median Fluorescent Intensity was analyzed using a 4-parameter logistic curve-

fitting method to calculate the concentration of each analyte.  

 

3.12 Cell death/Cytotoxicity assay 

Quantification of cell death and cell lysis was based on the measurement of lactate 

dehydrogenase (LDH), released from the cytosol of cells with plasma membrane damage, using 

the Cytotoxicity Detection KitPLUS (LDH) (Roche; Cat# 04744926001). Treatments were performed 

as described above in the ‘‘Cell Culture and Treatments’’ section. Subsequently, LDH release was 
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measured by adding 100 µL of freshly prepared Reaction mixture to 100 µL supernatant in a 96-

well plate for 8 min at RT (protected from light). The reaction was stopped with 50 µL of the 

provided stop solution and absorbance was measured at 490 and 620 nm using a microplate 

reader (CLARIOstar Plus; BMG LabTech). Readings at 620 nm were subtracted from the readings 

at 490 nm. To determine the percentage cytotoxicity, the average absorbance values of the 

samples and controls was calculated (background subtracted from each) and substituted the 

resulting values in the following equation: 

 

Cytotoxicity (%) =  
exp. value − low control

high control − low control
 x 100 

 

Experimental controls included the background, low, and high control. Background control 

consisted of the assay medium only (without cells). In comparison, the low control consisted of 

cells treated with the assay medium only and the high control was prepared by adding 5 µL Lysis 

solution to cells and the incubating the plate at RT for 15 min. 

 

3.13 Statistical analyses 

Data are presented as mean ± standard error of mean (SEM) in all displayed diagrams. 

Statistical significance was calculated using an ordinary one-way ANOVA (analysis of variance) 

test followed by Tukey’s multiple comparisons test where the means of the test columns was 

compared individually to the mean of every other column. Normal distribution (Gaussian 

distribution) was assumed for all tests. ASC-Aβ and ASC-BSA complexes (containing 1.75 µM ASC) 



 46 

were not statistically compared to ASC only or ASC-αSyn complexes (containing 2.5 µM ASC) since 

they comprised of varying amounts of oligomerized ASC. Statistical significance was shown as: *p 

< 0.05, **p < 0.01, ***p < 0.001, ****p < 0.0001. All statistical analyses were performed using 

GraphPad Prism 9.0 (GraphPad Software Inc., San Diego, CA, USA).   

  



 47 

4. RESULTS 

4.1 Monomeric αSyn clusters around ASC fibrils, forming ASC-αSyn complexes 

The inflammasome adaptor protein, ASC, is observed to be elevated in the SNpc of PD 

patients and multiple preclinical PD models (197). Moreover, Aβ monomers have been 

demonstrated to associate and bind to extracellular, microglia-derived ASC specks (196). To 

reproduce previous findings from the literature in my experimental setup and establish a positive 

control, ASC-Aβ complexes were produced. First, we produced recombinant human ASC protein 

by large scale expression of ASC in E. coli BL21 cells. Upon protein purification by SEC (data not 

shown), ASC was observed only in its monomeric form with an approximate size of 25 kDa, as 

shown by immunoblot (Figure 5A). To induce oligomerization, purified ASC protein monomers 

were buffer exchanged to ice-cold PBS using an Amicon® Ultra 0.5mL Centrifugal Filter (10 kDa 

MWCO) and later transferred into LoBind tubes for 1 h at 37°C to enable ASC ‘prionoid’ activity, 

as previously described (193). ASC specks were subjected to SDS-PAGE and immunoblot analysis, 

confirming the generation of ASC monomers (~25 kDa), dimers (~50 kDa) and higher order 

oligomers (>50 kDa) (Figure 5A). Next, oligomerized ASC (1.75 µM) with a ~3-fold molar excess 

of monomeric Aβ (5 µM) was co-incubated for 16 h at 37°C to enable protein complex formation, 

as described. 

To characterize the ASC-Aβ complexes to be used as a positive control, negative stain 

electron microscopy (EM) was performed (193). The protein samples were applied to a glow 

discharged Copper grid and negatively stained with 2% uranyl acetate. In EM, ASC was seen to 

arrange into long, slightly twisted helical filaments showing a uniform surface (Figure 6A). In 

comparison, Aβ alone largely retained its monomeric form (Figure 6D). 



 48 

 
 
 

 
 
Figure 5. Experimental workflow used in this study. 

(A) Schematic drawing of the formation of human oligomerized ASC. Purified A6 ASC protein 
(produced by Dr. David Cai) was transferred into LoBind tubes and oligomer formation was 
induced by incubation of ASC at 37°C for 1 h to enable ASC ‘prionoid’ activity, as described 
previously (193). Oligomerized ASC was produced and subjected to SDS-PAGE and Western blot 
analysis. Immunoblotting with an anti-ASC antibody identified bands for ASC at molecular masses 
corresponding to ASC monomers (~25 kDa), dimers (~50 kDa), and higher-order oligomers (>50 
kDa). Data courtesy of Dr. David Cai. (B) Human monomeric αSyn (StressMarq; SPR-321) was 
subjected to SDS-PAGE and Western blot analysis, confirming its purity. (C) Schematic drawing of 
the ASC-αSyn complex-building protocol. Fibrillary ASC (2.5 µM) and αSyn monomers (2.5 µM) 
were incubated in DMEM/F12 containing 1% FBS and 1% P-S in LoBind Tubes at 37°C for 16 h. (D) 
Schematic drawing of the experimental setup used in this study. ASC-Aβ (1.75 µM ASC-5 µM Aβ) 
and ASC-BSA (1.75 µM ASC-5 µM BSA) were used as positive and negative controls, respectively 
(193). Figure was created with BioRender.com.  
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As expected, in samples that were co-incubated, Aβ monomers were found in close proximity to 

ASC fibrils, forming ASC-Aβ complexes (Figure 6E) (193).  

After establishing the positive control, oligomerized ASC (2.5 µM; Figure 5A) was co-

incubated with a 1:1 molar ratio of human, monomeric αSyn (2.5 µM; Figure 5B) for 16 h at 37°C 

to produce ASC-αSyn complexes (Figure 5B). αSyn alone maintained its monomeric structure 

under these conditions (Figure 6B), as observed in the literature, and clustered around ASC fibrils 

when co-incubated, confirming the binding of both proteins and the formation of ASC-αSyn 

complexes by EM (Figure 6C) (205). Both ASC-αSyn and ASC-Aβ complexes also revealed unbound 

αSyn and Aβ, respectively, suggesting not all monomers bind to the ASC fibrils. 

 

4.2 ASC-Aβ complexes activate the NLRP3 inflammasome 

Before assessing NLRP3 inflammasome activation in response to ASC-Aβ and ASC-αSyn 

complexes, mouse SIM-A9 microglia, a relatively novel cell line from spontaneously immortalized 

murine microglia, were characterized as a suitable in vitro model system (206). Microglia were 

chosen for experimentation since they are the resident immune effector cells of the CNS that 

express a wide array of PRRs, wherein the NLRP3 inflammasome is best characterized to mediate 

sterile inflammation in microglia (110,112). In addition, microglia have been reported to express 

all NLRP3 inflammasome components and substrates (113). SIM-A9 microglia expressed 

microglia/macrophage-specific proteins, ionized calcium-binding adapter molecule 1 (Iba-1) and 

cluster of differentiation 68 (CD68), suggesting the cells retained their microglial properties after 

their expansion (Figure 7). Conversely, SIM-A9 cells were not immunoreactive to either 

microtubule-associated protein 2 (MAP2) or glial fibrillary acidic protein (GFAP), signifying that   
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Figure 6. αSyn clusters around ASC fibrils, forming ASC-αSyn complexes. 

(A–E) Transmission electron microscopy images of ASC fibrils (A), αSyn monomers (B), ASC-αSyn 
complex (C), Aβ monomers (D) and ASC-Aβ complex (E). ASC-Aβ complex was used as a positive 
control. Scale bars, 200 nm (A–E). 
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Figure 7. SIM-A9 cells express microglia/macrophage-specific proteins. 

Immunocytochemical detection of Iba-1 and CD68, two microglia/macrophage-specific proteins, 
and MAP2 and GFAP, a marker for neurons and astrocytes, respectively, in untreated mouse SIM-
A9 cells. Right panel shows secondary antibody controls against rabbit Iba-1 (rabbit Alexa 568), 
rabbit CD68 (rabbit Alexa 488), mouse MAP2 (mouse Alexa 568), and rabbit GFAP (rabbit Alexa 
488). Hoechst 33258 highlights the cell nuclei. Images were taken at 20x magnification. Scale 
bars, 50 µm.   
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they do not express neuron- or astrocyte-specific proteins, respectively (Figure 7). Based on these 

findings, I concluded that SIM-A9 cells exhibit a microglia phenotype despite having been 

suggested to also display a neuronal-like morphology. 

To analyze the effect of the ASC-Aβ complexes on NLRP3 inflammasome activation and 

subsequent IL-1β release in mouse SIM-A9 microglia, cells were primed with 100 ng/ml LPS for 3 

h and stimulated with 1.75 µM ASC, 5 µM Aβ, or ASC-Aβ complexes for 12 h in DMEM/F12 media 

containing 1% FBS and 1% P-S. As expected, LPS stimulation of microglia induced priming of the 

inflammasome, as shown by an increased protein expression of the NLRP3 sensor in the cell 

lysate compared to untreated cells (Figure 8A and 8B). The addition of a second treatment post-

LPS, including Aβ and ASC-Aβ complexes, led to further increases in the expression of NLRP3, 

signifying higher activation of the NLRP3 inflammasome. Interestingly, non-specific bands were 

observed near the molecular weight of ASC (~25 kDa) when probing for NLRP3 in the ASC-Aβ 

complex-treated group (Figure 8C), implying that NLRP3 particles may be a part of the ASC signal 

amplification platform (135). The levels of pro-caspase-1 remained relatively unaltered; however, 

cleaved caspase-1 peptide (p20) was undetectable in these samples (Figure 8A). Conversely, 

caspase-1-dependent IL-1β secretion was observed in response to treatment with ASC-Aβ 

complexes (Figure 8D), signifying occurrence of caspase-1 activation (and a technical limitation 

of detecting cleaved caspase-1 directly under these conditions). Compared to ASC and Aβ alone, 

the ASC-Aβ complexes produced a synergistic effect in the release of IL-1β.  

To gain insight into the release of additional pro-inflammatory cytokines and chemokines, 

a multiplex bead array assay was performed. In principle, a mixture of colored beads coated with 

specific antibodies bind the analyte of interest, allowing for detection of numerous analytes 
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within the same sample in one experiment. The biotinylated detection antibodies, in turn, bind 

the analyte and an analyte-antibody sandwich is formed. Streptavidin conjugated with 

phycoerythrin (PE) binds the biotinylated detection antibodies and the signal strength of PE is 

proportional to the concentration of the specific analyte. LPS priming alone was sufficient to 

induce a multitude of pro-inflammatory cytokines and chemokines, including tumour necrosis 

factor-α (TNF-α), IL-6, C-X-C motif ligand 1 (KC, also referred to as CXCL1), IFNγ-induced protein 

10 (IP-10, also referred to as CXCL10), monocyte chemoattractant protein-1 (MCP-1, also referred 

to as CCL2), macrophage inflammatory protein-2 (MIP-2), and regulated on activation, normal T 

cell expressed and secreted (RANTES; also referred to as CCL5) (Figure 9). IL-1α, a cytokine of the 

IL-1 family, was also released in response to LPS priming and further augmented when stimulated 

with ASC-Aβ complexes (Figure 9A). Very low concentrations of LPS have been shown to induce 

the production of various cytokines and chemokines, including IL-6 and TNF-α, and serve as a 

potent innate immune stimulus (207). However, when assessing inflammasome-specific 

cytokines, such as IL-1β, both a priming and activation signal are required and the effect of LPS 

alone on cytokine release is significantly diminished (Figure 8F). Together, upregulation in the 

NLRP3 inflammasome-dependent IL-1β and further inflammatory cytokines support that ASC-Aβ 

complexes can elicit a pro-inflammatory response and serve as a context-relevant positive 

control. 

 

4.3 ASC-αSyn complexes activate the NLRP3 inflammasome 

The effects of ASC-αSyn complexes (Figure 6C) were next tested on SIM-A9 microglia to 

determine whether they too activate the NLRP3 inflammasome. Comparable to the treatments   
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Figure 8. ASC-Aβ complexes activate the NLRP3 inflammasome and induce IL-1β release. 

(A-C) Western blot analysis and quantification of cell lysates (20 µg) of SIM-A9 microglia primed 
for 3 h with 100 ng/mL LPS and exposed to 1.75 µM ASC, 5 µM Aβ, or 1.75 µM ASC-5 µM Aβ 
complexes for 12 h. Blot of cell lysates of SIM-A9 microglia (A) was immunostained for NLRP3, 
caspase-1 and β-actin (loading control). Data was collected from one independent experiment (n 
= 1) and normalized to β-actin. Using the normalized values, the fold change (ratio of the 
experimental sample to the UT control) for each sample was calculated. (C) Full blot probed with 
an anti-NLRP3 antibody. (D) IL-1β levels in conditioned medium of SIM-A9 microglia (n = 1 single 
experiment with triplicate treatments for all conditions). The graphs are presented as mean ± 
SEM. Recombinant human Aβ (Biomatik) was used in these experiments.  
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Figure 9. ASC-Aβ complexes induce pro-inflammatory cytokine and chemokine release. 

(A–H) IL-1α (A), TNF-α (B), IL-6 (C), KC (D), IP-10 (E), MCP-1 (F), MIP-2 (G) and RANTES (H) levels 
in conditioned medium of SIM-A9 microglia after 3 h exposure of 100 ng/ml LPS followed by 12 
h exposure of 1.75 µM ASC, 5 µM Aβ, or 1.75 µM ASC-5 µM Aβ complexes, as revealed by 
a MILLIPLEX® Mouse Cytokine/Chemokine Magnetic Bead Panel. Data was collected from one 
single experiment (n = 1) with two technical replicates per assay (N = 2). All graphs are presented 
as mean ± SEM. Recombinant human Aβ (Biomatik) was used in these experiments.  
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with ASC-Aβ complexes, SIM-A9 microglia were primed with 100 ng/ml LPS for 3 h followed by 

treatment with 2.5 µM ASC, 2.5 µM αSyn, ASC-αSyn complexes or controls for 24 h in DMEM/F12 

media containing 1% FBS and 1% P-S (as shown in Figure 5C). ASC-Aβ complexes were utilised as 

a positive control, whereas ASC-BSA complexes were employed as a negative, non-amyloidogenic 

control to confirm specific interactions of ASC to αSyn and subsequent inflammatory responses. 

Compared to untreated cells, LPS treatment only induced priming of the NLRP3 inflammasome 

(~5.1-fold increase), as revealed via ICC with an anti-NLRP3 antibody (Figure 10A and 10B). 

Untreated microglia also expressed a baseline level of NLRP3, as microglia are constantly involved 

in immune surveillance and are not considered inactive in their ‘resting’ state, as historically 

described (113,208). Following LPS priming, treatment with αSyn, ASC and ASC-αSyn complexes 

displayed an increased fluorescence intensity similar to ASC-Aβ complexes, suggesting activation 

of the NLRP3 inflammasome (Figure 10A and 10B). After 27 h of treatments and NLRP3 

inflammasome activation, microglia displayed unique morphologies, suggestive of an alteration 

in homeostasis (Figure 10A; bottom row). 

Upon inflammasome activation, ASC assembles into an ASC speck, a large protein 

complex. ASC speck formation has been used as a readout for inflammasome activation (209). 

Cell-derived ASC specks can be observed as they reach a diameter between ~800 and 1000 nm 

and in most cells only one speck forms upon inflammasome activation (210). In contrast to the 

LPS control, treatment with ASC-αSyn complexes demonstrated a significant increase in ASC 

speck formation when probed with an anti-ASC antibody and a phalloidin conjugate to highlight 

filamentous actin (F-actin) (Figure 11A and 11B). Additionally, ASC-αSyn complex-treated cells 

displayed a ~1.7- and 2.5-fold increase in ASC specks than ASC and αSyn treatments alone, 
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Figure 10. ASC-αSyn complexes activate the NLRP3 inflammasome via increased expression of 
NLRP3. 

(A–B) Immunocytochemical detection and quantification of NLRP3 protein (B) in mouse SIM-A9 
microglia after 3 h exposure of 100 ng/ml LPS followed by 24 h exposure of ASC, αSyn, or ASC-
αSyn complexes. Anti-NLRP3 antibody was used for the detection of NLRP3. Images were taken 
at 20x and 63x magnification. Scale bars, 50 µm. Data was collected from three independent 
experiments (n = 3). The graph is presented as mean ± SEM and was analyzed by one-way ANOVA 
followed by Tukey’s post-hoc multiple comparisons test, where “ns” indicates not significant.  
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Figure 11. ASC-αSyn complexes activate the NLRP3 inflammasome via increased ASC speck 
formation. 

(A–B) Immunocytochemical detection and quantification of ASC specks (B) in mouse SIM-A9 
microglia after 3 h exposure of 100 ng/ml LPS followed by 24 h exposure of ASC, αSyn, or ASC-
αSyn complexes. Anti-ASC antibody was used for the detection of ASC. (C and D) 3D projection 
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of extracellular (C) and intracellular (D) ASC specks from ASC-αSyn complex-treated cells. Yellow 
arrowheads point to the same ASC speck, highlighting its intracellular localization (A and D). 
*Arrowheads show ASC specks, which are ~1 µm in size. Images were taken at 20x and 63x 
magnification. Scale bars, 20 (C and D) and 50 µm (A). Data were collected from three 
independent experiments (n = 3). The graph is presented as mean ± SEM and was analyzed by 
one-way ANOVA followed by Tukey’s post-hoc multiple comparisons test. Levels of significance 
are indicated as follows: *p < 0.05. Asterisks indicate significance between groups.  
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respectively, signifying an amplified level of NLRP3 inflammasome activation (Figure 11B). 

Interestingly, ASC specks are released by inflammasome-activated cells into the extracellular 

space, where they outlive cells and continue to recruit and activate pro-caspase-1 and catalyze 

the maturation of IL-1β (137,138). 3D projections of microglia treated with ASC-αSyn complexes 

confirmed both the extracellular (Figure 11C) and intracellular (Figure 11D) localization of ASC 

specks with respect to F-actin. Localization of ASC specks is better illustrated when observing 3D 

projection movies (Figure S1). Due to the addition of recombinant ASC to induce inflammasome 

activation, incubation with an anti-ASC antibody also highlighted numerous, recombinant ASC 

structures of large sizes amongst cell-derived ASC specks. Thus, endogenous ASC specks were 

counted for analysis based on known size and localization; this analysis requires further 

optimization for more accurate quantification. 

Next, to monitor caspase-1 cleavage post-ASC speck formation, I examined caspase-1 

activity using the FAM-FLICA® Caspase-1 assay after 24 h of ASC-αSyn complex treatment. 

Fluorescent-labeled inhibitor of caspases (FLICA) is a cell-permeant, non-cytotoxic probe that 

covalently binds to active caspase enzymes by recognizing a specific amino acid sequence (YVAD) 

that is sandwiched between a green, fluorescent label, carboxyfluorescein (FAM), and a 

fluoromethyl ketone (FMK) (211,212). Compared to ASC and αSyn alone, immunofluorescence 

microscopy analysis revealed increased caspase-1 activity in response to ASC-αSyn treatment (2- 

and 6-fold increase in the number of active caspase-1 cells, respectively; Figure 12A and 12B). In 

the ASC-αSyn complex-treated sample, a higher number of cells appeared brighter in the green 

channel, indicating an increased level of caspase-1 activity (Figure 12A). Remarkably, activated 

caspase-1-positive cells resembled cells undergoing pyroptosis, displaying nuclear condensation,   
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Figure 12. ASC-αSyn complexes increase caspase-1 activity using FAM-YVAD-FMK. 

(A–B) Immunocytochemical detection and quantification of caspase-1 activity in mouse SIM-A9 
microglia after 3 h exposure of 100 ng/ml LPS followed by 24 h exposure of ASC, αSyn, or ASC-
αSyn complexes. The FAM-FLICA® Caspase-1 (YVAD) Assay Kit was used for the detection of 
caspase-1 activity. Images were taken at 20x and 63x magnification. Scale bars, 50 𝜇m. Data was 
collected from three independent experiments (n = 3). The graph is presented as mean ± SEM 
and was analyzed by one-way ANOVA followed by Tukey’s post-hoc multiple comparisons test. 
Levels of significance are indicated as follows: *p < 0.05. Asterisks indicate significance between 
groups.   
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membrane ballooning and rupture (Figure 12A; bottom row) (174). Previously while establishing 

the positive control, cleaved caspase-1 was undetectable in response to ASC-Aβ treatment by 

immunoblotting yet displayed caspase-1-dependent release of cytokines, such as of IL-1β (Figure 

8A and 8F). Here, caspase-1 activation was visualized, thus supporting the findings of ASC-Aβ 

complex formation as a positive control (193). In contrast, ASC-BSA complexes generated a 

similar activity for caspase-1 to that of ASC exposure only, confirming its non-cytotoxic effects, in 

contrast to the effects of binding of αSyn or Aβ to ASC. Overall, ASC-αSyn complexes amplified 

the pro-inflammatory response mediated by the NLRP3 inflammasome and the resulting 

activation of caspase-1.  

To further assess the effects of ASC-αSyn complexes on NLRP3 inflammasome activation 

and support the findings from above, Western blot analysis of cell lysates was performed using 

antibodies against NLRP3, caspase-1 and GSDMD (Figure 13). Comparable to the 

immunofluorescence microscopy analysis, priming with LPS and stimulation with the various 

inducers increased NLRP3 protein levels in comparison to untreated cells, indicating activation of 

the NLRP3 inflammasome (Figure 13B). Again, cleaved caspase-1 (p20) peptide was not 

detectable under these experimental conditions; however, a reduction in the full-length caspase-

1 protein was observed, indirectly implying conversion to the cleaved caspase-1 subunits (Figure 

13C). ASC-αSyn complex-treated cells displayed a significant, 1.3-fold decrease in full-length 

caspase-1 compared to LPS alone whereas ASC-treated cells revealed a trend towards a decrease 

(p-value = 0.09; Figure 13C). On the contrary, insignificant differences were observed in the full-

length protein levels of GSDMD (Figure 13D). GSDMD, a substrate of caspase-1, is required for 

pyroptosis and for the secretion of IL-1β (116). Yet compared to LPS- and αSyn-treated cells,  
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Figure 13. Detection of the NLRP3 inflammasome pathway via immunoblotting. 

(A–E) Western blot analysis and quantification of cell lysates from SIM-A9 microglia that were 
primed for 3 h with 100 ng/mL LPS and exposed to ASC, αSyn, or ASC-αSyn complexes for 24 h. 
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Blots of cell lysates of SIM-A9 microglia (B–E) were stained for NLRP3 (B), caspase-1 (C), and full-
length and cleaved GSDMD (D and E). Data were collected from three (D and E) or four (B and C) 
independent experiments (n = 3 or 4) and normalized to the total protein stain (Ponceau S). Using 
the normalized values, the fold change (ratio of the experimental sample to the UT control) for 
each sample was calculated. All graphs are presented as mean ± SEM and were analyzed by one-
way ANOVA followed by Tukey’s post-hoc multiple comparisons test. Levels of significance are 
indicated as follows: *p < 0.05. Asterisks indicate significance between groups and “ns” indicates 
not significant. 
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Figure 14. Detection of the NLRP3 inflammasome pathway via Simple Western. 

(A–G) Simple Western analysis of cell lysates from SIM-A9 microglia that were primed for 3 h with 
100 ng/mL LPS and exposed to ASC, αSyn, or ASC-αSyn complexes for 24 h. Virtual blot-like 
images (A-C) display chemiluminescent signal generated from peak areas after incubation with 
primary antibodies against NLRP3 (A and D), full-length caspase-1 (B and E), and full-length (C 
and F) and cleaved GSDMD (C and G). β-actin was used as a protein loading control. Data were 
collected from two independent experiments (n = 2). All graphs are presented as mean ± SEM. 
Data courtesy of Ewa Baumann (A-C).  
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augmented levels of cleaved GSDMD were detected in all the experimental conditions containing 

oligomerized ASC, suggesting the induction of pore formation and pyroptosis (Figure 13E). Similar 

results were demonstrated using Simple Western-based readouts of the cell lysates to detect the 

protein levels of NLRP3, full-length and cleaved caspase-1 and GSDMD (Figure 14). In general, 

Simple Western-based detection systems provide more precise and sensitive quantification of 

protein expression levels, wherein proteins are size-separated in capillaries, compared to 

conventional immunoblotting (213,214). Likewise, LPS priming upregulated NLRP3 at the protein 

level (Figure 14D). Treatment with inflammasome activators, including oligomerized ASC and 

ASC-αSyn complexes, following LPS priming also reduced the levels of full-length caspase-1, 

suggesting cleavage of caspase-1 into its subunits (Figure 14E). Importantly, Simple Western 

analysis further revealed a major reduction in full-length GSDMD, specifically in response to 

oligomerized ASC and ASC-αSyn complexes (Figure 14F). Correspondingly, a significant increase 

in cleaved GSDMD levels was observed, signifying NLRP3 inflammasome activation and 

pyroptosis induction (Figure 14G). 

 

4.4 ASC-αSyn complexes trigger NLRP3- and caspase-1-dependent IL-1β/IL-18 

processing 

Activation of caspase-1 leads to the maturation of both IL-1β and IL-18 (115). To measure 

the subsequent release of IL-1β and IL-18 into the extracellular space following NLRP3 

inflammasome activation with ASC-αSyn complexes, IL-1β and IL-18 ELISAs were performed. 

Stimulation of microglia with ASC-αSyn complexes led to a significant increase in IL-1β release 

compared with αSyn (p-value < 0.0001) and ASC alone (p-value = 0.0025; Figure 15A). Equally, a  
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Figure 15. ASC-αSyn complexes induce IL-1β and IL-18 release without significant cell death. 

(A and B) IL-1β (A) and IL-18 (B) levels in conditioned medium of SIM-A9 microglia after priming 
with LPS for 3 h followed by treatment with ASC, αSyn, or ASC-αSyn complexes for 24 h. (C) IL-1β 
levels in conditioned medium of SIM-A9 microglia after exposure to ASC for 12 h with or without 
LPS priming for 3 h. (D) LDH release measurements after treatment with different inducers. Data 
were collected from three (D), four (A and C), or six (B) independent experiments (n = 3, 4 or 6). 
All graphs are presented as mean ± SEM and were analyzed by one-way ANOVA followed by 
Tukey’s post-hoc multiple comparisons test. Levels of significance are indicated as follows: **p < 
0.01, ****p < 0.0001. Asterisks indicate significance between groups and “ns” indicates not 
significant. 
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Figure 16. ASC-αSyn complexes induce pro-inflammatory cytokine and chemokine release. 

Pro-inflammatory cytokine (A–C) and chemokine (D–H) levels in conditioned medium of SIM-A9 
microglia after 3 h exposure of 100 ng/ml LPS followed by 12 h exposure of 1.75 µM ASC, 5 µM 
αSyn, or 1.75 µM ASC-5 µM αSyn complexes. (A-I) IL-1α (A), TNFα (B), IL-6 (C), IP-10 (D), MCP-1 
(E), KC (F), MIP-2 (G) and RANTES (H) levels were assessed by a MILLIPLEX® Mouse 
Cytokine/Chemokine Magnetic Bead Panel. Data were collected from a single independent 
experiment (n = 1) with three technical replicates per assay (N = 3). All graphs are presented as 
mean ± SEM.  
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significant increase in IL-18 release was observed in response to ASC-αSyn complexes compared 

to ASC alone (p-value < 0.0001; Figure 15B). Treatment with LPS and αSyn alone resulted in 

undetectable amounts of IL-1β and IL-18, suggesting they do not activate the NLRP3 

inflammasome. Rather, the observed effects are beyond synergism and the pro-inflammatory 

response is driven by the presence of ASC specks. Intriguingly, the addition of oligomerized ASC 

only without LPS priming displayed a diminished IL-1β release, suggesting priming of the NLRP3 

inflammasome (Signal 1) is required for a canonical, pro-inflammatory NLRP3 inflammasome 

response (Figure 15C). To analyze the effect of the ASC-αSyn complexes on microglia survival, 

release of LDH in response to ASC-αSyn treatment was used as an indicator of cell death. 

Irrespective of LPS priming or ASC-αSyn stimulation, microglia displayed minimal release of LDH, 

suggesting low levels of cell death and high cell survival during prolonged treatments of 27 h 

altogether (Figure 15D). To gain a better understanding of the inflammatory response, a 

multiplex bead array assay (described above) was performed. LPS priming and ASC-αSyn 

complexes were sufficient to induce a multitude of pro-inflammatory cytokines and chemokines, 

including IL-1α, TNF-α, IL-6, IP-10, MCP-1, KC, MIP-2, and RANTES (Figure 16). Together, these 

findings suggest that ASC-αSyn complexes activate the NLRP3 inflammasome and amplify the 

pro-inflammatory response in intact microglial cells to a greater extent than when compared to 

ASC and αSyn exposure only.  

Finally, phenotypical differences of microglia have been classified based on their 

morphological features in different contexts, such as neurodegenerative diseases (215). SIM-A9 

microglia were subjected to treatments and examined using phase-contrast microscopy (Figure 

S2). After 3 h of LPS exposure followed by 24 h of various treatments, SIM-A9 microglia exhibited 
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morphological changes (Figure S2). Untreated microglia revealed relatively small cell bodies with 

few cells revealing branched processes. Nonetheless, the addition of LPS transformed them to 

appear morphologically ramified with longer, branched processes, potentially for scanning of the 

microenvironment for extracellular dangers (70,71). Following NLRP3 inflammasome priming 

with LPS, the addition of an activation signal (i.e., via ASC-αSyn complexes) activated microglia 

into an amoeboid phenotype, where such cells are spherical in shape, have larger cell bodies and 

lack abundant processes. To conclude, microglial SIM-A9 cells demonstrated morphological 

differences when eliciting a pro-inflammatory response via the NLRP3 inflammasome, potentially 

suggesting an imbalance in their homeostatic functions. 
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5. DISCUSSION  

Inflammation produced by the innate immune system is a protective immune response 

that is tightly regulated by the host to prevail against invading pathogens. However, excessive 

inflammation can lead to the production of high concentrations of cytotoxic molecules and may 

trigger chronic or systemic inflammatory diseases (96,97). Inflammasomes are significant 

contributors to innate immunity, and one of the most extensively studied inflammasome 

complexes is NLRP3 (110). The NLRP3 inflammasome elicits a pro-inflammatory response 

mediated by caspase-1, members of the IL-1 family of cytokines and pyroptotic cell death. A 

growing body of literature has recognized αSyn aggregation, microglial NLRP3 inflammasome 

activation and presence of ASC specks in PD, the latter of which may interact with αSyn and 

contribute to hyperactivation of the inflammatory response in ways that are yet not well 

understood (137,197). In this thesis, I have demonstrated that in an in vitro model of mammalian 

microglia the presence of oligomerized ASC when combined with exogenous, human αSyn 

monomers contributes to an amplified inflammatory response driven that is mediated by the 

endogenous NLRP3 inflammasome. 

 

5.1 Oligomerized ASC binds monomeric amyloid proteins 

Upon NLRP3 inflammasome activation by PAMPs and DAMPs, NLRP3 recruits the adaptor 

protein ASC and pro-caspase-1 via homotypic interactions. Caspase-1 activation leads to the 

processing of IL-1β, IL-18, and GSDMD, which contribute to the inflammatory response. 

Importantly, a perinuclear punctate structure composed of insoluble and aggregated ASC, 

referred to as an ‘ASC speck’ is also formed during NLRP3 activation and is considered a hallmark 
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of inflammasome activation (209,216,217). Under physiological conditions, ASC is a monomer 

diffusely distributed throughout the cytosol; nonetheless, this protein has started to emerge as 

a critical player in the pathogenesis of numerous diseases involving inflammatory processes. 

Recent studies have suggested that ASC specks display prion-like polymerization and 

supramolecular organizing center (SMOC)-like threshold properties (218,219). Franklin et al. 

(2014) revealed that after pyroptosis, ASC specks accumulate rapidly in the extracellular space, 

where they promote further maturation of IL-1β (137). In addition, phagocytosis of ASC specks 

by macrophages induced lysosomal damage and nucleation of soluble ASC, as well as activation 

of IL-1β in recipient cells (137). More recently, microglia-derived ASC specks cross-seed Aβ and 

exposure of primary microglia to exogenous ASC and ASC-Aβ complexes resulted in a vicious cycle 

involving amplified NLRP3 inflammasome activity and reduced Aβ clearance in the presence of 

ASC (193,196). These findings suggested a potential mechanism for disease progression in AD, 

wherein Aβ clearance by microglia is prevented. In this study, I first re-demonstrated the binding 

of Aβ monomers to ASC specks (Figure 6E) and stimulation of microglial cells to ASC-Aβ 

complexes that induced the release of IL-1β (Figure 8F) as well as of numerous pro-inflammatory 

cytokines and chemokines (Figure 9); this observation, served as a positive control in my 

approach.  

Post-mortem brain tissues from PD patients and preclinical PD models have 

demonstrated up-regulated ASC levels and the formation of ASC specks in the SN of PD patients 

and striatum of mice (197). Further, in pilot biomarker studies, when compared to control 

individuals, gene expression levels of ASC have been found to be elevated in peripheral blood 

mononuclear cells of PD patients (220). αSyn, a pathologically relevant protein of PD, can be 
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released into the extracellular space upon neuronal damage and be scavenged by neighbouring 

microglia to induce its activation (54,60,221,222). Considering similar studies reporting sustained 

microglial NLRP3 inflammasome activity upon αSyn exposure and the ability of ASC to cross-seed 

amyloid formation-prone proteins, I hypothesized that monomeric αSyn, which also represents 

an amyloidogenic protein, may bind to ASC specks in the extracellular space (Figure 4). Indeed, 

via EM, I observed the presence of monomeric, recombinant human αSyn in close association 

with ASC fibrils when co-incubated in vitro, thereby producing ASC-αSyn complexes (Figure 6C). 

Numerous studies have revealed that microglial interaction with αSyn depends on its structure, 

with fibrillar αSyn inducing the greatest inflammatory response via NLRP3 activation and IL-1β 

release, reflecting microglial activation (18,89,197,223). In comparison, monomeric αSyn by itself 

was found to provoke only a minimal pro-inflammatory state, or none at all (Figures 11-15) 

(18,89). In my hypothesis, pro-inflammatory responses could be initiated by ASC specks in the 

presence of a non-pathogenic form of αSyn, generating an augmented response compared to 

ASC alone. Hence, the reason to employ αSyn monomers. Despite ASC and αSyn being in close 

proximity of each other, it remains unclear how αSyn may bind to ASC fibrils structurally.  

Mutagenesis studies have shown that the clustering of ASC-PYD domain filaments and 

their condensation into ASC specks is mediated by the ASC-CARD domain exposed to the surface 

of the filament initiated by the ASC-PYD domain (183). Importantly, ASC filament formation 

serves as a signal amplification mechanism for inflammasome-mediated cytokine production 

(106). However, filament formation of the CARD domain only is almost completely disturbed due 

to mutations within the CARD domain, suggesting the ASC-CARD domain is required for speck 

formation and downstream signaling (184). Furthermore, full-length human ASC carrying 
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mutations within the PYD-PYD interface and CARD domain, rendering it incapable of filament 

formation, does not cross-seed Aβ aggregation and decreases the release of IL-1β, suggesting 

that the filamentous structure of ASC is required for NLRP3 inflammasome activation in response 

to ASC-Aβ complexes (196). On the other hand, αSyn truncation of the C-terminal domain can 

increase exposure of the NAC region, thus promoting a pro-aggregatory conformational state 

(33). As such, caspase-1 performs truncation of αSyn at the C-terminal (at Asp121) in neurons to 

induce αSyn aggregation and neuroinflammation, which aggravates cytotoxicity and creates a 

positive-feedback loop (18,162,183). Conversely, caspase-1 inhibition rescued neuronal cells 

from αSyn-induced toxicity. In addition, Lewy bodies isolated from postmortem PD brains were 

positively stained for both caspase-1 and αSyn, substantiating their co-existence in Lewy bodies 

and supporting the belief that caspase-1 may be involved in generating the truncated αSyn found 

in Lewy bodies (199). Based on the size of the Lewy body core and what is known about the ASC 

speck’s ability to cross-seed protein aggregation, it has been speculated that ASC specks can likely 

be found in the core of αSyn Lewy bodies comparably to Aβ plaques (126,196). Truncation of the 

C-terminal has been estimated to occur in 10-30% of total αSyn within Lewy bodies (34). Studies 

have similarly shown that caspase-cleaved tau (at Asp421) can also become prionoid, seed tau 

aggregation and activate microglia (224–226). Finally, ASC specks have an intrinsic property to 

co-aggregate cytosolic proteins on their surface through non-specific hydrophobic interactions, 

indicating a role for ASC specks as supramolecular platforms and allowing extracellular amyloid 

proteins to cross-seed (140). 
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5.2 LPS acts as a PAMP to prime the NLRP3 inflammasome 

 I next hypothesized that microglial exposure to ASC-αSyn complexes activates the NLRP3 

inflammasome and amplifies the pro-inflammatory response. To test my hypothesis, I first 

primed mouse SIM-A9 microglia with LPS for 3 h (Figure 5C), replicating signal 1 of canonical 

NLRP3 inflammasome activation (Figure 3B). LPS, a component of gram-negative bacteria, is the 

most common pro-inflammatory priming stimulus for microglia to influence the transcription of 

inflammasome components via TLR4 engagement, both in vitro and in vivo (227,228). TLR4 

stimulation by LPS initiates translocation of NF-κB from the cytoplasm into the nucleus to induce 

gene transcription of Nlrp3 and pro-IL-1 (117,118). As expected, LPS priming alone induced an 

increase in NLRP3 protein levels (Figures 10B, 13B, and 14D). Though, a very minor rise was 

observed in the formation of cell-derived ASC specks and caspase-1 activity compared to other 

treatments, suggesting that LPS primes the NLRP3 inflammasome as a PAMP but does not prompt 

its assembly/activation (Figures 11B and 12B). In addition, LPS induced negligible or undetectable 

levels of IL-1β and IL-18 release in cell-free supernatants (Figure 15A and 15B), supporting the 

notion that LPS acts as a priming signal for the NLRP3 inflammasome. Nonetheless, LPS alone 

triggered the release of non-inflammasome-specific cytokines and chemokines (Figure 16). 

Activation of NF-κB, via LPS stimulation, increases the production of inflammatory cytokines, 

chemokines and adhesion molecules, yet also regulates cell proliferation, apoptosis, 

morphogenesis and differentiation (229). Thus, NF-κB serves as a central inflammatory mediator 

in many signaling pathways. Lower concentrations of LPS have shown to induce the production 

of various cytokines and chemokines, including IL-6 and TNF-α, and serve as a potent innate 

immune stimulus in other contexts (207).  
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Non-inflammasome-related cytokines, such as TNF-α or type I IFN, may also enhance the 

priming process of inflammasome activation, yet the mechanisms by which they contribute to 

inflammasome priming remain to be fully characterized (152,230,231). Certainly, as 

neuroinflammation has been strongly linked in the pathogenesis of PD, recent studies have used 

LPS to model the pro-inflammatory events seen in clinical PD (232). Some PD patients have raised 

serum LPS levels, which may reflect increased intestinal permeability and gut dysfunction evident 

in the early stages of PD, highlighting a specific disease subtype where inflammation may precede 

neurodegeneration (233,234). Peripheral stimulation of the innate immune system with LPS has 

shown to cause an exaggerated neuroinflammatory response and promote microglial 

hyperactivity in aged mice that is associated with the exaggerated induction of IL-1β (235). 

Interestingly, acute administration of LPS in different regions of the brain does not lead to 

permanent neuronal damage, except for in the substantia nigra (79,236–238). Sterile, chronic, 

and low-grade inflammation involving immunosenescence, commonly termed as 

‘inflammageing’ (understood to be not simply a consequence of increased chronological age), 

may also contribute to the increased priming and activation of the NLRP3 inflammasome and 

thus development of neurodegeneration (239–241). The role of LPS in the context of PD and LPS 

models of PD has been reviewed in these articles in more depth (232,234). 

 

5.3 ASC-αSyn complexes upregulate upstream NLRP3 inflammasome components 

Following LPS priming and a wash step to ensure canonical NLRP3 activation, microglia 

were exposed to ASC-αSyn complexes and controls for 24 h, mimicking signal 2 of canonical 

NLRP3 inflammasome activation (Figure 5C). Compared to LPS alone, stimulation with DAMPs, 
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including αSyn, oligomerized ASC, and ASC-αSyn complexes, all led to enhanced levels of the 

NLRP3 sensor, implying additional activation of the NLRP3 inflammasome (Figure 10B). Yet, 

Western blot and Simple Western analysis revealed similar levels of NLRP3 to LPS priming 

(Figures 13B and 14D). In PD, inflammasome activation is one of the most well-delineated 

inflammatory pathogenic factors (242–244). Importantly, NLRP3 inflammasome activation has 

been recognized in post-mortem brains of human PD patients (197,245). 

Next, I further monitored NLRP3 activation and assessed endogenous ASC speck 

formation as it is used as a simple upstream readout for inflammasome activation (209). ASC-

dependent inflammasome activation is complemented by rapid rearrangement of the NLR and 

ASC into a singular, perinuclear, punctate ‘speck’ structure of ~1 μm (209,246). The ASC speck is 

believed to act as a SMOC, which are higher-order structures that locally concentrate weakly 

interacting proteins required for signal transduction (218,219,247). SMOC assembly is tightly 

regulated, and ASC speck formation follows the SMOC assembly mechanism, signifying that 

specks enable inflammasome proteins to adopt a conformation that efficiently senses the 

activation signal (218,247,248). Notably, signal-induced polymerization of ASC into SMOCs allows 

for an all-or-none response, which is only triggered once a threshold is exceeded. Here, exposure 

of microglia to ASC-αSyn complexes generated the highest number of ASC specks, indicating 

heightened NLRP3 inflammasome activation when compared to αSyn and ASC only (Figure 11B). 

Speck formation in vitro is rapid, as NLRP3 and ASC oligomerize under three min to form a speck 

and produce a concomitant drop in the cytosolic ASC concentration by nearly 200-fold (217,249–

251). However, the kinetics of speck formation differ in vivo. For instance, the speck size in 

Zebrafish stabilizes after a continuous growth period of 15 min (252). Typically, inflammasome 
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activation is characterized by the presence of a single speck per cell. Yet, multiple studies have 

described the induction of multiple ASC specks per cell, suggestive of differing experimental 

conditions and mechanisms that may stimulate ASC speck formation  . Lastly, the prion-like 

structure of ASC specks is resistant to proteolytic degradation, serving as amplification 

mechanisms for inflammasome signaling and leads to a toxic, chronic progressive inflammatory 

state (discussed more in-depth below) (106,108,208,209). 

Visualization of ASC specks was enabled with the use of an anti-ASC, polyclonal antibody 

and subsequent confocal microscopy. However, one crucial limitation is the co-appearance of 

recombinant human ASC protein used to stimulate microglia in vitro. Both cell-derived and 

recombinant human ASC were identified upon detection of ASC (Figure 11A). To perform 

accurate quantification of endogenous ASC specks formed in response to in vitro treatments, 

specks were manually quantified based on known localization, size, and appearance. Endogenous 

ASC specks are commonly localized to the perinucleus, although some ASC specks are found in 

the extracellular space (Figure 11A) (256). ASC specks may also be found in microglial processes 

in a potential attempt to offload their cellular cargo and/or perpetuate the inflammatory 

response, although this has been shown with αSyn (66). Moreover, ASC specks exhibit a diameter 

of ~1 μm and are circular in appearance. In contrast, ASC specks formed using recombinant ASC 

are of various sizes, mostly larger than 1 μm and sporadic in appearance (176). Larger, irregular-

shaped ASC specks were also observed near the cellular membrane or within microglia, 

suggesting internalization of the recombinant ASC as endogenous ASC specks are smaller, more 

uniform and frequently observed near the perinucleus (Figure 11A).  
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Due to the tendency of ASC to self-aggregate, it is unclear whether the endogenous 

structure resembles the complexes observed in vitro or upon ASC overexpression. Since the 

recombinant ASC expressed a polyhistidine (His)-tag, an approach that I attempted to overcome 

this limitation was co-incubating cells with an anti-His-tag antibody to detect recombinant ASC 

among the cell-derived ASC. Despite this, non-specific staining of Histidine was observed in all 

the cells (data not shown), restricting direct recognition of the exogenous ASC. On the other 

hand, biotinylation of ASC, which involves the process of covalently attaching biotin to ASC, can 

be performed. Thus, biotinylated ASC may be used for in vitro treatments and cells can be 

incubated with a streptavidin antibody to detect the recombinant ASC specks, since biotin binds 

to streptavidin with an extremely high affinity and high specificity. In addition, to further 

discriminate between cell-derived and recombinant human ASC used for cell treatment, a mouse-

specific anti-ASC antibody can be applied to visualize ASC aggregation and speck release into the 

extracellular environment. 

 

5.4 ASC-αSyn complexes act as a DAMP, amplifying downstream NLRP3 

inflammasome components 

 Caspase-1, an inflammatory caspase, is present as a zymogen that requires activation to 

mediate its effects. This can be accomplished through the assembly of an inflammasome complex 

(147). Upon NLRP3 inflammasome activation, pro-caspase-1 is self-activated by proteolytic 

cleavage and mature caspase-1 proteolytically cleaves downstream proteins, including pro-IL-1β 

and pro-IL-18 and GSDMD, into mature, biologically active forms. PD patients display increased 

caspase-1, localized exclusively within microglia in the SNpc or systemically circulating caspase-1 
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and IL-1β (197,198). Additionally, caspase-1 is also present at the core of Lewy bodies extracted 

from the brains of PD patients (199). To investigate caspase-1 cleavage, Western blot analysis of 

cell lysates was performed. Surprisingly, cleaved caspase-1 (p20) was undetected in all samples 

(Figure 13A). Yet, a reduction in the full-length caspase-1 protein was observed, indirectly 

indicating conversion to the cleaved caspase-1 subunits (Figure 13C). To provide more sensitive 

detection and precise quantification of protein expression levels compared to immunoblotting, 

Simple Western immunoassays were performed using the Wes instrument (176,177). In Wes, 

proteins are size-separated in capillaries, where they are incubated with primary and HRP-

conjugated secondary antibodies and Luminol/peroxide in a fully automated Western blotting 

workflow. The produced chemiluminescence is detected at several exposure times and 

automatically quantified where the chemiluminescent signal can be displayed as an 

electropherogram or as a virtual blot-like image, as shown in Figure 14A-C. Detection of cleaved 

caspase-1 (and thus, GSDMD) via immunoblotting can be difficult due to lack of relative 

abundance of the cleaved proteins compared to the total protein, hence the Simple Western may 

be a better alternative. Likewise, only decreases in the full-length caspase-1 protein were 

observed (Figure 14E), suggesting the overall abundance of cleaved caspase-1 in these samples 

is too low for detection. 

 To overcome the challenge of cleaved caspase-1 detection, the FAM-FLICA® Caspase-1 

assay was employed. FLICA is a non-cytotoxic probe that covalently binds to active caspase 

enzymes by recognizing a specific 4 amino acid sequence (YVAD) that includes an aspartic acid 

(D) residue in the P1 position that is sandwiched between a green, fluorescent label (FAM) and a 

FMK (211,212). Binding of the YVAD amino acid sequence will retain the green, fluorescent signal 
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within the cell. FLICA is also cell-permeant and efficiently diffuses in and out of all cells, wherein 

unbound FLICA can be diffused out of the cell during wash steps. Ultimately, apoptotic and 

pyroptotic cells retain a higher concentration of FLICA and fluoresce brighter than healthy cells. 

Compared to ASC and αSyn alone, imaging analysis revealed increased caspase-1 activity in 

response to ASC-αSyn treatment (Figure 12B), a trend analogous to that of the increase in ASC 

speck formation. Microglia exposure to ASC-BSA complexes revealed comparable caspase-1 

activity to ASC alone (Figure 12B), suggesting ASC specks preferentially bind to monomeric forms 

of αSyn and Aβ, but not BSA, to provoke an inflammatory response. Moreover, 12% of ASC-αSyn 

complex-treated cells displayed caspase-1 activity, indicating an overall, low inflammatory 

response, which may contribute to lack of caspase-1 detection in cell lysates via immunoblotting 

or Simple Western. It is important to note that processed caspase-1 has a short half-life of 

approximately nine min in cell extracts, while other caspases are active for hours (257). 

Consequently, while maturation dramatically increases catalytic activity, it also limits activity to 

a very short time and thus, an appropriate detection technique is required (258). 

 Post-caspase-1 activation, two potent cytokines of the IL-1 family of ligands involved in 

host defense, IL-1β and IL-18, are processed to mediate an inflammatory response (148,149). 

Both cytokines IL-1β and IL-18 are recognized by type 1 IL-1 receptor (IL-1R1) and IL-18R, 

respectively, and IL-1R1 signalling links with TLR signalling to competently manage invading 

pathogens (222). IL-1β is the most well-characterised and studied of the 11 IL-1 family members, 

where its release has been observed in numerous inflammatory contexts, such as 

autoinflammatory and autoimmune diseases, respiratory diseases, cardiovascular disorders, and 

neurodegenerative conditions among many others (259). While IL-18 is constitutively expressed, 
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IL-1β is absent in cells from healthy individuals and thus requires a series of intracellular events, 

including inflammasome assembly, before it can trigger inflammation. IL-1β is a product of a 

limited number of cells, such as tissue macrophages and blood monocytes, and transcription is 

the rate-limiting step in the production of IL-1β (260). Here, exposure of LPS-primed microglia to 

ASC-αSyn complexes generated a statistically significant release of both IL-1β (Figure 15A) and 

IL-18 (Figure 15B) compared to ASC only, suggesting ASC-αSyn complexes elicit the production of 

an amplified inflammatory cytokine cascade. Unlike IL-1β, ASC-Aβ complex formation did not 

induce the release of IL-18 to the same extent as ASC-αSyn complexes (Figure 15B), likely 

reflecting the difference in the addition of oligomerized ASC (1.75 µM ASC used for ASC-Aβ 

complex vs. 2.5 µM ASC used for ASC-αSyn complex) and the constitutive expression of IL-18. In 

contrast, exposure of SIM-A9 microglia to LPS and αSyn alone failed to produce any measurable 

IL-1β and IL-18 cytokine release, proposing that the inflammatory response is driven by the 

presence of recombinant ASC specks and influences αSyn monomers in ways that are yet 

unknown. 

IL-1β and IL-18 are known to mediate numerous innate and adaptive immune responses 

that contribute to chronic inflammation (261). IL-1β exerts its effects by binding to IL-1R1, where 

its activation leads to the release and nuclear translocation of NF-κB (262). Next, NF-κB enhances 

transcription of genes for cytokines, including IL-1α, IL-1β, IL-6 and TNF-α, and supplementary 

chemokines (229). IL-1β can engage with TLR4 to initiate an inflammatory cytokine cascade to 

propagate inflammation since IL-1β can induce further expression of TNF-α and IL-6, while IL-18 

stimulates the production of IL-17 (128,263,264). Additionally, administration of IL-1β along with 

other cytokines into a healthy animal has shown to display significantly greater tissue damage, 
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suggesting a functional reinforcement in the action of these inflammatory features (216). IL-1β 

and additional inflammatory cytokines may also alter blood-brain barrier permeability and 

influence the transport of substances from systemic circulation into the brain, which may allow 

infiltrating immune cells to enter the parenchyma and promote neurotoxicity (265). Upon CNS 

injury and NLRP3 inflammasome activation, it has been demonstrated that IL-1β and IL-18 

cytokines promote the local recruitment of leukocytes to the CNS (266,267). IL-1β and IL-18 also 

play a known role in the polarization of IL-17-producing T-helper 17 (Th17) cells and IFN-γ-

producing Th1 cells, respectively (268–271). It is worth noting that Th17 cells are injurious to 

dopaminergic neurons in models of PD and other neurological disorders (272,273). Moreover, IL-

1β, along with IL-23, promotes granulocyte-macrophage colony-stimulating factor expression by 

T cells (226), implicating microglial-T cell interactions. In addition to inducing pro-inflammatory 

cytokines, IL-18 has been described to upregulate adhesion molecules, stimulate NK cell activity, 

and recruit monocytes and T lymphocytes (153,274). Synergistically with IL-12, IL-18 induces IFN-

γ production and inhibition of angiogenesis (274,275). In addition, IL-18, in collaboration with IL-

3, induces basophils and mast cells to produce IL-4 and IL-13 (276,277). Notably, in experimental 

mice models of AD, microglia activated with Aβ produced IL-1β that further promoted synthesis 

and aggregation of neurotoxic Aβ peptides (278). Likewise, released cytokines may influence 

endogenously expressed αSyn to misfold and aggregate. Thus, aggregated αSyn may prompt a 

subsequent inflammatory response that continues to release cytokines and justify the sustained 

presence of inflammation and progressive αSyn pathology (279). Increased levels of 

inflammatory cytokines, including IL-1β, IL-18, IL-6, and TNF-α, have been detected in the 

cerebrospinal fluid of PD patients when compared with controls (280–282). Post-mortem analysis 



 85 

of patients with neurodegenerative diseases present with both neuroinflammation as well as 

tissue damage, making it challenging to confirm whether elevated IL-1β levels contribute to 

pathological changes as a primary event (as during the induction of pyroptosis) or secondary 

event (as in the process of debris clearance following cell death). Multiple studies using 

experimental brain injury models have implied that IL-1β-induced leukocyte recruitment and 

additional inflammatory processes leads to neuronal damage and cell death (283,284). However, 

persistent expression of the IL-1 receptor antagonist has been shown to cause a delay in pro-

inflammatory cytokine induction and improvement in healing and neurological recovery 

following traumatic brain injury (285). Importantly, blocking IL-1 in a broad spectrum of diseases 

to treat inflammation has been proposed as a therapeutic strategy (260,286). This has been 

shown to result in a rapid and sustained reduction in disease severity (260,286). Overall, both IL-

1β and IL-18 perform central roles in mediating various innate and adaptive immune responses 

that may reinforce neuroinflammation in a positive-feedback manner. 

 To gain insight into the general inflammatory response, a multiplex assay probing several 

inflammatory markers was performed as IL-1β and IL-18 influence several immune responses and 

cell types that may propagate the overall inflammatory response. As briefly discussed above, LPS 

priming and subsequent treatment with different DAMPs resulted in the release of numerous 

cytokines and chemokines (Figure 16). The pro-inflammatory cytokines, IL-1α, IL-6, and TNF-α, 

are essential for coordinating cell-mediated immune responses and modulating the immune 

system. They generally regulate growth, cell activation, differentiation, and orient immune cells 

to the sites of infection with the purpose to control and eliminate the intracellular pathogens 

(170). Moreover, IL-1α is considered an alarmin, an indicator of cell damage (287). IL-1β and IL-
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1α bind to the same receptor and have mostly overlapping inflammatory activities, hence 

displaying a similar trend in cytokine release (Figure 16A) (288). On the other hand, chemokines, 

for instance IP-10, KC, MCP-1, MIP-2 and RANTES, are cytokines with chemotactic activities. They 

also perform a critical role in regulating the movement and localization of lymphocytes and a 

subset of dendritic cells (DCs) (171). While chemokines are not specific to the inflammasomes, 

they can mediate inflammation, thus displaying a more robust and distinctive trend compared to 

the release of IL-1β (Figures 7E-I and 14E-I). Of note, the release of IL-4 and IL-10, two notable 

anti-inflammatory cytokines that serve to suppress inflammation and immunity, were also 

assessed. Upon treatment with ASC-αSyn complexes, no detectable amounts of both IL-4 and IL-

10 were observed (data not shown), highlighting the balance of the immune system being 

skewed towards pro-inflammatory signaling (289). 

 Along with processing of the pro-inflammatory cytokines IL-1β and IL-18, caspase-1 also 

induces pyroptosis, a necrotic form of regulated cell death characterized by plasma membrane 

permeabilization and rupture. Pyroptotic cell death is mediated by proteolytically activating the 

pore-forming GSDMD, which allows the release of cytokines into the extracellular space. 

Following the discovery of GSDMD’s role in executing pyroptosis, many studies have noted 

differences in GSDMD expression and cleavage within the nigrostriatal pathway of PD mouse 

models (290–293). Both in vivo and in vitro experiments have demonstrated that GSDMD 

contributes to glial activation and death of dopaminergic neurons across different PD models. In 

addition, ablation of Gsdmd in mice attenuated PD-like pathology by reducing dopaminergic 

neuronal death, microglial activation, and the detrimental transformation of both microglia and 

astrocytes (294). In this study, insignificant differences were observed in the full-length protein 
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levels of GSDMD in response to stimulation with ASC-αSyn complexes via immunoblotting 

(Figures 13D). Yet compared to LPS- and αSyn-treated cells, increased levels of cleaved GSDMD 

were detected, suggesting the moderate induction of pore formation and pyroptosis (Figure 13E 

and 14G). Moreover, Simple Western analysis revealed a greater disparity in full-length GSDMD 

levels in microglia treated with LPS and αSyn alone, compared to ASC only and ASC-αSyn 

complexes (Figure 14F). Treatment of SIM-A9 microglia with all inflammasome inducers also led 

to minimal detection of LDH, denoting a lack of cell death in this model (Figure 15D). Pyroptosis 

results in the release of large amounts of immature pro-caspase-1 and pro-IL-1β which constitute 

the dominant bands in immunoblots of cell-free supernatants from inflammasome-activated 

cells, although this was not shown in this study (295). GSDMD cleavage and pyroptosis may be 

occurring at a minor level, making it challenging to detect significant differences.  

Most, not all, inflammasome activators induce both cytokine maturation and pyroptosis. 

Formation of N-GSDMD, which forms transmembrane pores, is required for efficient cytokine 

release (175,178,179,181). In this study, relatively low levels of GSDMD correspond with reduced 

caspase-1 activity and lower release of IL-1β and IL-18. Similar treatments with ASC-Aβ complexes 

led to more robust responses in mouse primary microglia, proposing the treatments in SIM-A9 

microglia in this study do not generate an inflammatory response to the same extent (193). 

Furthermore, the mere existence of GSDMD, a caspase-1 substrate, does not define the 

pyroptotic outcome of inflammasome activation. It has been previously discussed that caspase-

1 activation does not necessarily cause pyroptosis in all scenarios and thus, secretion of cytokines 

and release of ASC specks does not always rely on pyroptosis (139). Different types of cell death 

are likely to be present simultaneously, for example apoptosis and necroptosis. Thus, this has led 
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to the recent establishment and development of the concept of ‘PANoptosis’. PANoptosis is an 

intricate form of inflammatory cell death that integrates components from other programmed 

cell death pathways, including pyroptosis, apoptosis, and necroptosis (296,297). In addition, cell 

death is not essential for caspase-1-mediated IL-1β activation and secretion (298). After the 

genetic identification of GSDMD as a regulator of pyroptosis, following work demonstrated that 

GSDMD pore formation does not necessarily lead to death (299,300). Cell death after GSDMD 

pore formation is regulated and can be delayed or avoided altogether (301). In this experimental 

setup, the lack of significant cell death and pyroptosis suggests that much of the ASC speck 

release may occur through more complex, yet unexplored mechanisms. High GSDMD expression 

is necessary for pyroptosis, whereas low expression can influence the response towards 

apoptosis. For instance, in the absence of GSDMD, caspase-1 has been shown to induce 

apoptosis, but not pyroptosis (302,303). Mast cells, which express low levels of GSDMD, undergo 

caspase‐1‐dependent apoptosis accompanied by the activation of caspase‐3 (303). Once 

activated within a GSDMD-low cell, caspase-3 may bias caspase-1-induced cell death towards 

apoptosis through the inactivation of GSDMD (302,304). This suggests that a threshold 

expression level of GSDMD is required to trigger pyroptosis as caspase‐1‐induced apoptosis and 

pyroptosis suppress each other (173). Regarding the release of cytokines, IL-1β has shown to be 

released via GSDMD‐formed pores when blocking cell membrane rupture (300). Further studies 

have reported IL-1β release from living cells via GSDMD pores, referred to as hyperactivation 

(299,305). Hyperactivation has also been observed in macrophages and DCs (306,307). Overall, 

the expression level of GSDMD and the number of GSDMD pores determine the induction of 

pyroptosis and the maturation and release of cytokines. 
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5.5 ASC specks serve as a signal amplification platform  

Traditionally, many therapeutics for PD and AD have focused solely on targeting amyloid 

protein accumulation, overlooking other co-pathologies. As a result, there are very few effective 

therapies to treat or slow the progression of these debilitating, neurodegenerative diseases, and 

diagnostic tools for early detection and monitoring disease progression are limited. Many 

treatments only targeting amyloid protein accumulation have shown to be of clinical 

insignificance, encouraging a re-evaluation of the existing therapeutic strategies 

(201,202,308,309).  

In recent years, an inflammation-based hypothesis has gained traction to explain the 

mechanism of neurodegenerative disease progression. This hypothesis suggests that 

inflammation may act as an early inciting event in the disease, contributing to protein misfolding 

and aggregation, which in turn reinforces neuroinflammation in a positive-feedback manner, 

ultimately leading to neurodegeneration (241). Sterile inflammation, which occurs as a result of 

trauma, ischemia-reperfusion injury or chemically induced injury that typically occurs in the 

absence of any microorganisms, is one factor amongst others that contributes to the progression 

of CNS pathologies (310,311). In particular, inhibition of the NLRP3 inflammasome, a key 

mediator of sterile inflammation, has emerged as a therapeutic target where many inhibitors 

have been validated through in vitro studies and in vivo experiments in animal models of NLRP3-

associated disorders (312,313). While many inhibitors directly or indirectly target the NLRP3 

protein, some studies have targeted the adaptor protein ASC and inhibition of ASC 

oligomerization for the treatment of inflammatory diseases (314,315). Inhibition of ASC 

oligomerization has shown to prevent activation of pro-caspase-1 and inhibit the activation of 
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different ASC-dependent inflammasomes. On the other hand, serum ASC (also referred to as 

PYCARD) has been proposed as a new diagnostic marker for patients with rheumatoid arthritis 

(RA), where it plays a key role in the progression of RA (316). Given ongoing research into the 

role of ASC specks in neurodegenerative diseases, ASC may emerge as a potential biomarker. It 

is important to note that the hypothesis and mechanistic insights from these findings may be 

particularly relevant to an inflammatory subtype of PD, potentially stemming from sterile 

inflammation, as it is a heterogenous disease and may differ from patient to patient.  

As mentioned above, prion-like ASC specks can serve as a platform for the propagation of 

inflammation and protein aggregation that drives PD. I hypothesized that binding of αSyn to ASC 

in the extracellular space of the brain leads to the formation of ASC-αSyn complexes, which are 

recognized as novel danger signals by microglia leading to NLRP3 inflammasome activation and 

amplification of the pro-inflammatory response. Here, I demonstrated that treatment of murine 

SIM-A9 microglia with ASC-αSyn complexes generated a pro-inflammatory response 

characterized by an increase in cell-derived ASC specks, caspase-1 activity, IL-1β and IL-18 

release, and GSDMD cleavage. All the responses were consistently higher compared to treatment 

with ASC or αSyn alone and displayed similar trends, where results of the downstream 

components in the inflammasome pathway were more profound. Notably, αSyn alone minimally 

activated the NLRP3 inflammasome, suggesting ASC specks largely contribute to the amplified 

pro-inflammatory response. 
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Figure 17. Binding of ASC and αSyn induces a feed-forward inflammatory cycle in microglia. 

Different conformations of αSyn induce microglia priming and activation via cell surface 
receptors, such as TLRs. Under a healthy state, activated microglia internalize and reduce αSyn 
deposition. During microglia activation, components of the NLRP3 inflammasome, including the 
inflammasome adaptor protein ASC and cleaved pro-inflammatory cytokines IL-1β and IL-18, are 
released into the extracellular space to mediate an apt inflammatory response. In the 
extracellular space, oligomerized ASC, referred to as ASC specks, may bind extracellular αSyn and 
form ASC-αSyn complexes. ASC-αSyn complexes trigger chronic activation of the NLRP3 
inflammasome and may influence αSyn aggregation and promote phagocytic exhaustion, 
reducing αSyn clearance by microglia. Highly activated and pyroptotic microglia release ASC 
specks, pro-inflammatory cytokines, and engulfed ASC-αSyn complexes, triggering an excessively 
toxic environment and a feed-forward cycle. ASC specks may nucleate soluble ASC and αSyn, 
amplifying the inflammatory response. Adapted from Friker et al. (2020). Figure was created with 
BioRender.com   
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Overall, it appears that the ASC specks and formation of ASC-αSyn complexes induce a 

positive-feedback cycle in microglia (Figure 17) (126). Firstly, neuronally-derived αSyn and/or  

misfolded αSyn aggregates bind to TLRs which activates the expression of NLRP3 and pro-IL-1β 

to prime the cell for inflammasome assembly in a NF-kB signaling dependent manner (Signal 1) 

(91,92). Extracellular, misfolded αSyn aggregates may also be internalized by the phagolysosomal 

pathway yet can escape lysosomal degradation and prompt assembly of the NLRP3 

inflammasome (Signal 2) (317–319). Secondly, the NLRP3 inflammasome via caspase-1 in 

microglia catalyzes the processing of IL-1β and IL-18, which can be transferred extracellularly or 

released into the extracellular environment during pyroptosis for inflammatory signaling (174). 

In parallel, assembly of the NLRP3 inflammasome may progress to the formation of the ASC 

speck, a supramolecular complex with enhanced inflammatory signaling capacity, which may 

then be released into the extracellular environment following pyroptosis or some other non-

pyroptotic mechanism (109,135). There may be scenarios in which pyroptotic cell death is 

beneficial. For instance, in response to infection with intracellular pathogens (139). Considering 

the levels of caspase-1 activity and release of cytokines in this study, pyroptosis and cell death 

appeared to be of less importance than expected. The cellular response may also be dependent 

on the dose and length of treatments. Additionally, pyroptotic cell death is not advantageous 

when intrinsic danger, such as cell damage occurs. Prolonged cell survival may be more 

advantageous to allow optimal cytokine secretion to attract more immune cells (320). Thirdly, 

once in the extracellular space, the ASC speck remains functionally active as a molecular scaffold 

for cross-seeding of neuronally derived misfolded protein aggregation, inflammatory cytokine 

processing, and potentially pro-aggregatory modifications of other proteins 
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(137,138,193,196,199,225). The presence of an increase in ASC specks allows for nucleation of 

soluble ASC, serving as additional binding sites for extracellular αSyn and stimulating caspase-1 

independent of the inflammasome (135,321). Ultimately, this assists in initiating a cytokine storm 

and producing a feed-forward cycle. Histologic analysis of tissues from PD patients have 

identified an increase in ASC specks in the SN and observed ASC specks within and outside of 

microglial cells (322). Furthermore, PD‑derived αSyn aggregates combined with chronic 

inflammatory cues have demonstrated to promote a neurotoxic microglial phenotype (90). Next, 

the ASC speck can also propagate inflammation from one microglial cell to another by inducing a 

pro-inflammatory phenotype in cells that phagocytose the ASC speck but fail to degrade it 

(137,138). ASC activates the inflammasome after transition from a soluble to an insoluble state, 

possibly rendering them extremely stable and resistant to proteolytic degradation (323). Failed 

degradation of the ASC speck by microglial autophagy pathways results in the persistence of the 

active ASC speck contributing to an unregulated inflammatory response (193). Consequently, 

extracellular ASC specks can directly activate caspase-1 in the extracellular milieu together within 

the cell after being internalized by phagocytes (137). Altogether, the reviewed activities of the 

ASC speck involve its role in the propagation of inflammation and spreading of protein 

aggregation in a vicious cycle that contributes to the chronic progressive nature of PD and other 

neurodegenerative conditions in an ASC-dependent manner.  

 

5.6 Limitations of this study and other considerations  

In this thesis, there are some key limitations to note. The first limitation is the lack of a 

dose-response experiment to determine the optimal inflammatory response to ASC-αSyn 
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complexes. Inflammatory effects of oligomerized ASC uptake could be concentration-dependent 

and influenced by the balance between oligomerized ASC accumulation vs clearance (139). One 

way to test this hypothesis is to test different concentration ratios of complexes (e.g., 1:1 vs. 1:2 

molar ratio of ASC-αSyn) after various incubation times (e.g., 8, 12, 24, and 36 h of treatment) 

and monitor the subsequent release of either IL-1β or IL-18 as a downstream NLRP3 

inflammasome readout. It may also be noteworthy to repeat the experiment to investigate cell 

death by measuring LDH release, as increased caspase-1 and pyroptosis contribute to an 

enhanced inflammatory response. These experiments were partially attempted in my project 

(data not shown), yet they were not fully characterized and completed. Moreover, it is important 

to consider the oligomeric state of the recombinant ASC used. ASC oligomers of different sizes 

are generated by various factors and thus, the size of the ASC oligomers can impact the 

inflammatory response. Yu et al. (2023) revealed oligomerization degrees of ASC specks regulate 

the caspase-1 activation in the extracellular space, wherein ASC specks with a low 

oligomerization degree were shown to enhance the activation of caspase-1 (321). In theory, ASC 

specks with a low degree of oligomerization have more ASC-CARD available for the homotypic 

interactions between ASC-CARD and caspase-1-CARD, increasing the activation of caspase-1 

during inflammatory responses. Uncertainty of the oligomerization state during each 

independent experiment may also contribute to the variability in cellular responses. Another 

important limitation is the confirmation of the binding between αSyn and ASC. αSyn was 

observed to be in close association with ASC specks, yet whether the two proteins interact 

remains unknown. Performing a co-immunoprecipitation experiment, a popular technique to 

identify physiologically relevant protein-protein interactions, can help validate ASC-αSyn binding.  
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The mouse SIM-A9 microglial cell line used in this study as an in vitro culture model 

warrants consideration. SIM-A9 is a spontaneously immortalized microglial cell line derived from 

cerebral cortex of mouse pups (206). While mouse strains are commonly used to study human 

diseases, there are notable differences between the human and murine immune systems in both 

innate and adaptive responses (324). The organization of the immune system varies significantly 

between the species. In humans, resistance mechanisms are more prominent due to their longer 

lifespan, whereas tolerance mechanisms dominate in mice (325,326). Additionally, species-

specific differences exist in the activation and function of effector molecules released by immune 

cells to control pathogens. While many TLR-induced signaling pathways are highly conserved, 

mice show limited responses to TLR agonists (327). Microglia isolated from neonatal mice display 

a greater number of differentially expressed genes in response to DAMP treatment compared to 

microglia isolated from adult mice (328). Furthermore, microglia isolated from mice at different 

developmental stages have unique transcriptional signatures. Ex vivo human adult microglia 

exhibit a more pro-inflammatory profile than microglia from younger developmental stages, 

showing higher immune responsiveness by secreting increased levels of pro-inflammatory 

cytokines in response to LPS treatment compared to prenatal microglia (329). 

These interspecies differences highlight the need for human-based models to study 

neuroinflammation and immune responses more accurately. Human induced pluripotent stem 

cell (hiPSC)-derived microglia provide a promising alternative. Recent work from many 

laboratories has shown that hiPSCs can be differentiated into microglia-like cells that closely 

resemble primary human microglia in their ability to phagocytose, secrete cytokines, and respond 

to inflammatory stimuli (330–332). Human iPSC-derived microglia can be co-cultured with 
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neurons, astrocytes, microvascular endothelial cells, and other brain cell types in microfluidic 3D 

brain-chip models, better recapitulating the human brain’s cellular interactions and 

microenvironment (333). This approach allows for a more accurate investigation of 

neuroinflammatory processes, overcoming the limitations of murine models and offering deeper 

insights into human neuroinflammation. 

After the potential interaction of ASC and αSyn in the extracellular environment and 

sustained exposure of microglia to ASC-αSyn complex formation, I hypothesized that chronic 

NLRP3 inflammasome activation and neuronal exposure to ASC-αSyn complexes may negatively 

impact neuronal health (Figure 4). Studies carried out in preclinical models and human PD 

patients has documented that synaptic dysfunction and/or loss occurs early in the disease 

process (48). To determine the impact of ASC-αSyn complexes and microglia-driven responses on 

neuronal health, a co-culture system of microglia and neurons can be established. Microglia can 

be stimulated with the exogenous addition of ASC-αSyn complexes and neuronal health can be 

subsequently monitored. Otherwise, conditioned media from ASC-αSyn-treated microglia can be 

incubated with neurons to reveal neuronal and synaptic viability. 
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6. CONCLUSIONS AND FUTURE PERSPECTIVES 

 Neurodegenerative diseases represent a significant and growing societal challenge, with 

PD being the fastest growing neurological disease. In Canada alone, 30 new cases of PD are 

diagnosed every day (334). The heterogenous clinical manifestations in addition to the 

multifactorial background of PD suggests that the pathogenesis of PD may vary from patient to 

patient, highlighting the need for personalized therapies and development of specific diagnostic 

tests and biomarkers (335). This study highlights the complex molecular mechanisms underlying 

PD, particularly focusing on neuroinflammation. The research demonstrates that the activation 

of the microglial NLRP3 inflammasome results in the release of the inflammasome adaptor 

protein ASC as ASC specks outside the cell, which remain biologically active and are capable of 

cross-seeding amyloid proteins. The binding of ASC specks and amyloidogenic proteins results in 

their internalization, leading to reduced protein clearance and the amplification and 

perpetuation of pro-inflammatory responses in a molecular feed-forward cycle that can trigger 

neuronal damage. Overall, in this thesis, I have demonstrated that monomeric αSyn – when 

added to ASC – was found in close association with oligomerized ASC upon their co-incubation, 

producing ASC-αSyn complexes. I revealed mechanistic insights into how ASC-αSyn complexes 

elicit a pro-inflammatory response in microglia, amplify NLRP3 inflammasome activity in the 

presence of ASC, and contribute to a vicious cycle of inflammation.  

This project links the inflammasome adaptor protein ASC and αSyn to mechanisms that 

lead to neuroinflammation, which have relevance to PD and related α-synucleinopathies. 

Together, results from this study aid in pointing at a potential role of ASC specks in the 

pathophysiology of PD and highlight the importance of ASC-αSyn complex formation, such as an 
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early trigger, in the initiation of propagation and thus, the potential exacerbation, of αSyn 

pathology. A detailed understanding of ASC-αSyn binding and internalization and neuronal 

exposure to ASC-αSyn complexes warrants thorough investigation and may provide novel 

opportunities to characterize the early pathological events that would ultimately result in the 

degeneration of dopaminergic neurons. Lastly, ASC-αSyn complexes can be targeted with 

available antibodies and inhibitors to demonstrate the direct role of ASC-αSyn complexes in 

amplifying NLRP3 inflammasome responses. 
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8. APPENDIX 
 
Figure S1. Localization of cell-derived ASC specks in ASC-αSyn complex-treated cells. 

3D projection movies and representative 63x magnification images of microglia treated with ASC-
αSyn complexes revealing intracellular and extracellular ASC specks localization with respect to 
F-actin. *Arrowheads show ASC specks, which are ~1 µm in size. Yellow arrowhead points to the 
ASC speck shown in Figure 11, highlighting its intracellular localization. Scale bars, 20 and 50 µm. 
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Figure S2. Microglia display morphological changes upon various inflammasome inducers. 

Phase contrast micrographs of mouse SIM-A9 microglia after 3 h exposure of 100 ng/ml LPS 
followed by 24 h exposure of ASC, αSyn, or ASC-αSyn complexes. UT cells display small cell 
bodies with some cells with branched processes. Treatment with LPS transforms microglia to 
appear ramified with long branched processes, potentially to scan the microenvironment for 
extracellular dangers. Addition of a second inducer after LPS treatment, such as ASC and/or 
αSyn, activates microglia into more of an “amoeboid” phenotype, where such cells are spherical 
in shape, have larger cell bodies and lack abundant processes. Images were taken at 20x 
magnification using the Leica DMIL microscope.  
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Table 2. List of primary antibodies used in this study. 

Antibody Reference Host/Clonality Application/Dilution 

NLRP3 [Cryo-2] AdipoGen 

AG-20B-0014-C100 
Mouse 

monoclonal 
ICC: 1:100 
IB: 1:1,000 

Simple Western: 1:100 

ASC [AL177] AdipoGen 
AG-25B-0006-C100 

Rabbit 
polyclonal 

ICC: 1:100 
IB: 1:1,000 

Caspase-1 [Casper-1] Adipogen 
AG-20B-0042 

Mouse 
monoclonal 

IB: 1:1,000 
Simple Western: 1:100 

GSDMD [EPR19828] Abcam 
ab209845 

Rabbit 
monoclonal 

IB: 1:1,000 
Simple Western: 1:100 

Iba-1 Fujifilm Wako 
019-19741 

Rabbit 
polyclonal 

ICC: 1:500 

CD68 [RM1031] Abcam 
ab303565 

Rabbit 
polyclonal 

ICC: 1:100 

MAP2 [HM-2] Sigma-Aldrich 
M4403 

Mouse 
monoclonal 

ICC: 1:250 

GFAP Dako 
Z0334 

Rabbit 
polyclonal 

ICC: 1:250 

αSyn [LB 509]  Abcam 
ab27766  

Mouse 
monoclonal 

IB: 1:1,000 

actin-HRP [AC-15] Sigma 
A3854 

Mouse 
monoclonal 

Simple Western: 1:500 

 
Table 3. List of secondary antibodies used in this study. 

Antibody Reference Form Application/Dilution 

Goat anti-mouse  Invitrogen 
A-11029 

Alexa Fluor™ 488-
conjugated 

ICC: 1:500 
 

Goat anti-rabbit Invitrogen 
A-11008 

Alexa Fluor™ 488-
conjugated 

ICC: 1:500 
 

Goat anti-rabbit Sigma 
A0545 

HRP-conjugated IB: 1:10,000 

Rabbit anti-mouse  Sigma 
A9044 

HRP-conjugated IB: 1:7,500 
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